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User ś Guide

Pipe Flow Module



C o n t a c t  I n f o r m a t i o n

Visit www.comsol.com/contact for a searchable list of all COMSOL offices and local 
representatives. From this web page, search the contacts and find a local sales 
representative, go to other COMSOL websites, request information and pricing, submit 
technical support queries, subscribe to the monthly eNews email newsletter, and much 
more. 

If you need to contact Technical Support, an online request form is located at 
www.comsol.com/support/contact.

Other useful links include:

• Technical Support www.comsol.com/support

• Software updates: www.comsol.com/support/updates

• Online community: www.comsol.com/community

• Events, conferences, and training: www.comsol.com/events

• Tutorials: www.comsol.com/products/tutorials

• Knowledge Base: www.comsol.com/support/knowledgebase

Part No. CM022801

P i p e  F l o w  M o d u l e  U s e r ’ s  G u i d e
  1998–2012 COMSOL

Protected by U.S. Patents 7,519,518; 7,596,474; and 7,623,991. Patents pending.

This Documentation and the Programs described herein are furnished under the COMSOL Software License 
Agreement (www.comsol.com/sla) and may be used or copied only under the terms of the license agree-
ment. 

COMSOL, COMSOL Desktop, COMSOL Multiphysics, and LiveLink are registered trademarks or trade-
marks of COMSOL AB. Other product or brand names are trademarks or registered trademarks of their 
respective holders.

Version: May 2012 COMSOL 4.3

pipe_ug.book  Page 1  Monday, April 23, 2012  5:04 PM

www.comsol.com/contact
http://www.comsol.com/support/contact/
http://www.comsol.com/support/
http://www.comsol.com/support/updates/
http://www.comsol.com/community/
http://www.comsol.com/events/
http://www.comsol.com/products/tutorials/
http://www.comsol.com/support/knowledgebase/
www.comsol.com/sla


pipe_ug.book  Page 3  Monday, April 23, 2012  5:04 PM
C o n t e n t s

C h a p t e r  1 :  I n t r o d u c t i o n

About the Pipe Flow Module  8

What Can the Pipe Flow Module Do? .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    8

Pipe Flow Module Interfaces   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    9

Show More Physics Options    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  10

Where Do I Access the Documentation and Model Library?   .   .   .   .   .   .  12

Typographical Conventions  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  14

Overview of the User’s Guide  17

C h a p t e r  2 :  T h e  F l u i d  F l o w  B r a n c h

Mechanisms for Modeling Fluid Flow  20

Coupling to Other Physics Interfaces  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  20

The Pipe Flow Interface  21

Edge, Boundary, Point, and Pair Features for the Pipe Flow Interface  .   .   .  22

Pipe Properties   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  23

Initial Values.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  25

Inlet.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  26

Outlet .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  26

No Flow .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  27

Pressure  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  27

Bend   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  28

Valve   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  29

Contraction / Expansion .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  29
C O N T E N T S  | 3



pipe_ug.book  Page 4  Monday, April 23, 2012  5:04 PM
Pump  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  30

T-Junction    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  31

The Non-Isothermal Pipe Flow Interface  33

Edge, Boundary, Point, and Pair Features for the Non-Isothermal Pipe Flow 

Interface .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  35

Fluid    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  36

Heat Transfer  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  37

The Water Hammer Interface  38

Edge, Boundary, Point, and Pair Features for the Water Hammer Interface .  39

Fluid Properties   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  40

Pipe Properties   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  41

Local Friction Loss  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  42

Closed.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  42

Velocity   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  42

Pressure  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  43

Theory for the Pipe Flow Interface  44

Flow Equations    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  44

References for the Pipe Flow Interface    .   .   .   .   .   .   .   .   .   .   .   .   .   .  52

Theory for the Water Hammer Interface  54

Flow Equations    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  54

References for the Water Hammer interface  .   .   .   .   .   .   .   .   .   .   .   .  56

C h a p t e r  3 :  T h e  H e a t  T r a n s f e r  B r a n c h

The Mechanisms for Heat Transfer  58

Coupling to Other Physics Interfaces  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  58
C O N T E N T S  | 4



pipe_ug.book  Page 5  Monday, April 23, 2012  5:04 PM
The Heat Transfer in Pipes Interface  60

Edge, Boundary, Point, and Pair Features for the Heat Transfer in 

Pipes Interface    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  61

Heat Transfer  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  61

Heat Source.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  62

Wall Heat Transfer  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  63

Internal Film Resistance   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  64

External Film Resistance  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  65

Wall Layer   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  66

Initial Values.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  67

Temperature   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  67

Heat Outflow  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  68

Theory for the Heat Transfer in Pipes Interface  69

The Heat Transfer Equation .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  69

Reference for the Heat Transfer in Pipes interface   .   .   .   .   .   .   .   .   .   .  76

C h a p t e r  4 :  T h e  C h e m i c a l  S p e c i e s  T r a n s p o r t  B r a n c h

The Transport of Diluted Species in Pipes Interface  78

Edge, Boundary, Point, and Pair Features for the Transport of Diluted 

Species in Pipes Interface .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  79

Convection and Diffusion.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  80

Initial Values.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  81

Reactions.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  81

Wall Mass Transfer  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  82

Concentration .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  82

Mass Outflow  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  83

The Reacting Pipe Flow Interface  84

Edge, Boundary, Point, and Pair Features for the Reacting Pipe Flow 

Interface .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  85

Pipe Properties    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  87

Initial Values.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  87

Fluid Properties   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  88

Convection and Diffusion.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  89
C O N T E N T S  | 5



6 | C O N T E N T S

pipe_ug.book  Page 6  Monday, April 23, 2012  5:04 PM
Fluid    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  90

Theory for the Transport of Diluted Species in Pipes Interface  91

C h a p t e r  5 :  T h e  A c o u s t i c s  B r a n c h

The Pipe Acoustics, Transient Interface  96

Edge, Boundary, Point, and Pair Features for the Pipe Acoustics, 

Transient Interface  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  97

Initial Values.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  98

Fluid Properties   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  99

Pipe Properties    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    100

Closed.   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    101

Open  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    101

Pressure  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    102

Velocity   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    102

Theory for the Pipe Acoustics, Transient Interface  104

Governing Equations   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    104

Theory for the Pipe Acoustics, Transient Interface Boundary Conditions.    107

Solving Transient Problems  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    108

References for the Pipe Acoustics, Transient Interface .   .   .   .   .   .   .   .    109

C h a p t e r  6 :  M a t e r i a l s

Material Library and Databases  112

About the Material Databases .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    112

About Using Materials in COMSOL .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    114

Opening the Material Browser    .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    117

Using Material Properties   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    118

Liquids and Gases Materials Database  119

Liquids and Gases Materials .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .    119

References for the Liquids and Gases Material Database .   .   .   .   .   .   .    121



pipe_ug.book  Page 7  Monday, April 23, 2012  5:04 PM
 1
I n t r o d u c t i o n
This guide describes the Pipe Flow Module, an optional add-on package for 
COMSOL Multiphysics designed to model and simulate incompressible flow, heat 
and mass transfer in pipes and channels with the Pipe Flow physics. Compressible 
hydraulic transients and acoustics waves can also be modeled using the Water 
Hammer physics and Pipe Acoustics physics, respectively. The Pipe Flow module 
can address problems involving flow velocity, pressure, temperature and sound 
waves in cooling systems, ventilation systems, pipe systems in the chemical 
processing industry, and pipelines in the oil and gas industry.

This chapter introduces you to the capabilities of this module. A summary of the 
physics interfaces and where you can find documentation and model examples is 
also included. The last section is a brief overview with links to each chapter in this 
guide.

In this chapter:

• About the Pipe Flow Module

• Overview of the User’s Guide
 7
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Abou t  t h e  P i p e  F l ow Modu l e

These topics are included in this section:

• What Can the Pipe Flow Module Do?

• Pipe Flow Module Interfaces

• Show More Physics Options

• Where Do I Access the Documentation and Model Library?

• Typographical Conventions

What Can the Pipe Flow Module Do?

The Pipe Flow Module is intended for the modeling and simulation of flow of 
incompressible fluids in pipe and channel systems, as well as compressible hydraulic 
transients and acoustics waves. Typical simulations yield the velocity, pressure 
variation, and temperature in systems of pipes and channels. Hydraulic transients 
resulting from a valve that is closed rapidly in a pipe network is referred to water 
hammer, which can be modeled too. The module can be used to design and optimize 
complex cooling systems in turbines, ventilation systems in buildings, pipe systems in 
chemical processes, and pipelines in the oil and gas industry.

In common for pipes and channels that can be modeled is that the pipe length is large 
enough so that the flow inside can be considered fully developed. Piping components 
such as bends, valves, T-junctions, contractions/expansions and pumps are also 
available in the module.

The module includes these physics:

• The Pipe Flow physics computes the pressure and velocity field in isothermal pipe 
systems.

• The Heat Transfer in Pipes physics computes the energy balance in pipe systems 
but receives the flow field as a value or as a known solved field. Wall heat transfer to 
the surroundings is included.

• The Transport of Diluted Species in Pipes physics solves a mass balance equation 
for pipes in order to compute the concentration distribution of a solute in a dilute 
solution, considering diffusion, dispersion, convection, and chemical reactions.

• The Non-Isothermal Pipe Flow physics is a multiphysics interface that solves the 
flow, pressure, and temperature simultaneously and fully coupled.
1 :  I N T R O D U C T I O N
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• The Reacting Pipe Flow physics is a multiphysics interface that solves the flow, 
pressure, temperature, and reacting species transport simultaneously and fully 
coupled.

• The Water Hammer physics solves rapid hydraulic transients in pipe systems, taking 
the elastic properties of both the fluid and pipe wall into account.

• The Pipe Acoustics, Transient physics models sound waves in flexible pipe systems. 

The physics in the module define the conservation of momentum, energy, and mass of 
an fluid inside a pipe or channel system. The flow, pressure, temperature, and 
concentration fields across the pipe cross sections are modeled as cross-section 
averaged quantities, which only vary along the length of the pipes and channels. The 
pressure losses along the length of a pipe or in a pipe component are described using 
friction factor expressions. A broad range of built-in expressions for Darcy friction 
factors are used that cover the entire flow regime from laminar to turbulent flow, 
Newtonian and non-Newtonian fluids, different cross-sectional geometries, and a wide 
range of relative surface roughness values. In addition to the continuous frictional 
pressure drop along pipe stretches, pressure drops due to momentum changes in 
components such as bends, contractions, expansions, T-junctions and valves are 
computed through an extensive library of industry standard loss coefficients. Pumps 
are also available as components.

Pipe Flow Module Interfaces

INTERFACE ICON TAG SPACE 
DIMENSION

PRESET STUDIES

  Acoustics

 Acoustic-Structure Interaction 

Pipe Acoustics, Transient

Requires both the Pipe Flow 
Module and Acoustics Module.

patd 3D, 2D time dependent

 Chemical Species Transport

Reacting Pipe Flow rpfl 3D, 2D stationary; time 
dependent

Transport of Diluted Species in 
Pipes

dsp 3D, 2D stationary; time 
dependent
A B O U T  T H E  P I P E  F L O W  M O D U L E  |  9
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Show More Physics Options

There are several features available on many physics interfaces or individual nodes. This 
section is a short overview of the options and includes links to the COMSOL 
Multiphysics User’s Guide or COMSOL Multiphysics Reference Guide where 
additional information is available. 

To display additional features for the physics interfaces and feature nodes, click the 
Show button ( ) on the Model Builder and then select the applicable option.

 Fluid Flow

 Single-Phase Flow

Pipe Flow pfl 3D, 2D stationary; time 
dependent

Reacting Pipe Flow rpfl 3D, 2D stationary; time 
dependent

Water Hammer whtd 3D, 2D time dependent

Non-Isothermal Pipe Flow nipfl 3D, 2D stationary; time 
dependent

  Heat Transfer

Heat Transfer in Pipes htp 3D, 2D stationary; time 
dependent

INTERFACE ICON TAG SPACE 
DIMENSION

PRESET STUDIES

The links to the features described in the COMSOL Multiphysics User’s 
Guide and COMSOL Multiphysics Reference Guide do not work in the 
PDF, only from within the online help.

To locate and search all the documentation for this information, in 
COMSOL, select Help>Documentation from the main menu and either 
enter a search term or look under a specific module in the documentation 
tree.

Important

Tip
 1 :  I N T R O D U C T I O N
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After clicking the Show button ( ), some sections display on the settings window 
when a node is clicked and other features are available from the context menu when a 
node is right-clicked. For each, the additional sections that can be displayed include 
Equation, Advanced Settings, Discretization, Consistent Stabilization, and Inconsistent 

Stabilization.

You can also click the Expand Sections button ( ) in the Model Builder to always show 
some sections or click the Show button ( ) and select Reset to Default to reset to 
display only the Equation and Override and Contribution sections.

For most physics nodes, both the Equation and Override and Contribution sections are 
always available. Click the Show button ( ) and then select Equation View to display 
the Equation View node under all physics nodes in the Model Builder.

Availability of each feature, and whether it is described for a particular physics node, is 
based on the individual physics selected. For example, the Discretization, Advanced 

Settings, Consistent Stabilization, and Inconsistent Stabilization sections are often 
described individually throughout the documentation as there are unique settings. 

SECTION CROSS REFERENCE LOCATION IN 
COMSOL 
MULTIPHYSICS 
USER’S GUIDE OR 
REFERENCE GUIDE

Show More Options and 
Expand Sections

• Showing and Expanding Advanced 
Physics Sections

• The Model Builder Window

User’s Guide

Discretization • Show Discretization

• Element Types and Discretization

User’s Guide

 • Finite Elements

• Discretization of the Equations

Reference Guide

Discretization - Splitting 
of complex variables

Compile Equations Reference Guide

Pair Selection • Identity and Contact Pairs

• Specifying Boundary Conditions for 
Identity Pairs

User’s Guide

Consistent and 
Inconsistent Stabilization

Show Stabilization User’s Guide

• Stabilization Techniques

• Numerical Stabilization

Reference Guide
A B O U T  T H E  P I P E  F L O W  M O D U L E  |  11
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Where Do I Access the Documentation and Model Library?

A number of Internet resources provide more information about COMSOL 
Multiphysics, including licensing and technical information. The electronic 
documentation, Dynamic Help, and the Model Library are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N

The COMSOL Multiphysics User’s Guide and COMSOL Multiphysics Reference 
Guide describe all interfaces and functionality included with the basic COMSOL 
Multiphysics license. These guides also have instructions about how to use COMSOL 
Multiphysics and how to access the documentation electronically through the 
COMSOL Multiphysics help desk.

To locate and search all the documentation, in COMSOL Multiphysics:

• Press F1 for Dynamic Help, 

• Click the buttons on the toolbar, or

• Select Help>Documentation ( ) or Help>Dynamic Help ( ) from the main menu

and then either enter a search term or look under a specific module in the 
documentation tree.

T H E  M O D E L  L I B R A R Y

Each model comes with documentation that includes a theoretical background and 
step-by-step instructions to create the model. The models are available in COMSOL 

Geometry Working with Geometry User’s Guide

Constraint Settings Using Weak Constraints User’s Guide

SECTION CROSS REFERENCE LOCATION IN 
COMSOL 
MULTIPHYSICS 
USER’S GUIDE OR 
REFERENCE GUIDE

If you are reading the documentation as a PDF file on your computer, the 
blue links do not work to open a model or content referenced in a 
different user’s guide. However, if you are using the online help in 
COMSOL Multiphysics, these links work to other modules, model 
examples, and documentation sets.

Important
 1 :  I N T R O D U C T I O N
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as MPH-files that you can open for further investigation. You can use the step-by-step 
instructions and the actual models as a template for your own modeling and 
applications.

SI units are used to describe the relevant properties, parameters, and dimensions in 
most examples, but other unit systems are available.

To open the Model Library, select View>Model Library ( ) from the main menu, and 
then search by model name or browse under a module folder name. Click to highlight 
any model of interest, and select Open Model and PDF to open both the model and the 
documentation explaining how to build the model. Alternatively, click the Dynamic 

Help button ( ) or select Help>Documentation in COMSOL to search by name or 
browse by module.

The model libraries are updated on a regular basis by COMSOL in order to add new 
models and to improve existing models. Choose View>Model Library Update ( ) to 
update your model library to include the latest versions of the model examples.

If you have any feedback or suggestions for additional models for the library (including 
those developed by you), feel free to contact us at info@comsol.com.

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and case number is sent to you by 
email.
A B O U T  T H E  P I P E  F L O W  M O D U L E  |  13
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C O M S O L  WE B  S I T E S  

Typographical Conventions

All COMSOL user’s guides use a set of consistent typographical conventions that make 
it easier to follow the discussion, understand what you can expect to see on the 
graphical user interface (GUI), and know which data must be entered into various 
data-entry fields.

In particular, these conventions are used throughout the documentation:

Main Corporate web site www.comsol.com 

Worldwide contact information www.comsol.com/contact 

Technical Support main page www.comsol.com/support 

Support Knowledge Base www.comsol.com/support/knowledgebase 

Product updates www.comsol.com/support/updates 

COMSOL User Community www.comsol.com/community 

CONVENTION EXAMPLE

text highlighted in blue Click text highlighted in blue to go to other information 
in the PDF. When you are using the online help desk in 
COMSOL Multiphysics, these links also work to other 
modules, model examples, and documentation sets.

boldface font A boldface font indicates that the given word(s) appear 
exactly that way on the COMSOL Desktop (or, for toolbar 
buttons, in the corresponding tip). For example, the Model 
Builder window ( ) is often referred to and this is the 
window that contains the model tree. As another example, 
the instructions might say to click the Zoom Extents button 
( ), and this means that when you hover over the button 
with your mouse, the same label displays on the COMSOL 
Desktop.

Forward arrow symbol > The forward arrow symbol > is instructing you to select a 
series of menu items in a specific order. For example, 
Options>Preferences is equivalent to: From the Options 
menu, choose Preferences.

Code (monospace) font A Code (monospace) font indicates you are to make a 
keyboard entry in the user interface. You might see an 
instruction such as “Enter (or type) 1.25 in the Current 
density field.” The monospace font also is an indication of 
programming code or a variable name. 
 1 :  I N T R O D U C T I O N
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K E Y  T O  T H E  G R A P H I C S

Throughout the documentation, additional icons are used to help navigate the 
information. These categories are used to draw your attention to the information 
based on the level of importance, although it is always recommended that you read 
these text boxes. 

Italic Code (monospace) 
font

An italic Code (monospace) font indicates user inputs and 
parts of names that can vary or be defined by the user.

Arrow brackets <> 
following the Code 
(monospace) or Code 
(italic) fonts

The arrow brackets included in round brackets after either 
a monospace Code or an italic Code font means that the 
content in the string can be freely chosen or entered by the 
user, such as feature tags. For example, 
model.geom(<tag>) where <tag> is the geometry’s tag 
(an identifier of your choice). 

When the string is predefined by COMSOL, no bracket is 
used and this indicates that this is a finite set, such as a 
feature name. 

ICON NAME DESCRIPTION

Caution A Caution icon is used to indicate that the user should proceed 
carefully and consider the next steps. It might mean that an 
action is required, or if the instructions are not followed, that 
there will be problems with the model solution.

Important An Important icon is used to indicate that the information 
provided is key to the model building, design, or solution. The 
information is of higher importance than a note or tip, and the 
user should endeavor to follow the instructions.

Note A Note icon is used to indicate that the information may be of 
use to the user. It is recommended that the user read the text.

Tip A Tip icon is used to provide information, reminders, shortcuts, 
suggestions of how to improve model design, and other 
information that may or may not be useful to the user.

See Also The See Also icon indicates that other useful information is 
located in the named section. If you are working on line, click 
the hyperlink to go to the information directly. When the link is 
outside of the current PDF document, the text indicates this, 
for example See The Laminar Flow Interface in the 
COMSOL Multiphysics User’s Guide. Note that if you are in 
COMSOL Multiphysics’ online help, the link will work.

CONVENTION EXAMPLE
A B O U T  T H E  P I P E  F L O W  M O D U L E  |  15
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Model The Model icon is used in the documentation as well as in 
COMSOL Multiphysics from the View>Model Library menu. If 
you are working online, click the link to go to the PDF version 
of the step-by-step instructions. In some cases, a model is only 
available if you have a license for a specific module. These 
examples occur in the COMSOL Multiphysics User’s Guide. 
The Model Library path describes how to find the actual model 
in COMSOL Multiphysics, for example 

If you have the RF Module, see Radar Cross Section: Model 
Library path RF_Module/Tutorial_Models/radar_cross_section

Space Dimension Another set of icons are also used in the Model Builder—the 
model space dimension is indicated by 0D , 1D , 1D 
axial symmetry , 2D , 2D axial symmetry , and 3D 

 icons. These icons are also used in the documentation to 
clearly list the differences to an interface, feature node, or 
theory section, which are based on space dimension.

ICON NAME DESCRIPTION
 1 :  I N T R O D U C T I O N
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Ove r v i ew o f  t h e  U s e r ’ s  Gu i d e

The Pipe Flow Module User’s Guide gets you started with modeling using COMSOL 
Multiphysics. The information in this guide is specific to this module. Instructions how 
to use COMSOL in general are included with the COMSOL Multiphysics User’s 
Guide. 

TA B L E  O F  C O N T E N T S  A N D  I N D E X

To help you navigate through this guide, see the Contents and Index. 

T H E  A C O U S T I C S  B R A N C H

The Acoustics Branch chapter describes the Pipe Acoustics, Transient interface and its 
theory. This interface requires both the Acoustics Module and the Pipe Flow Module.

T H E  F L U I D  F L O W  B R A N C H

The The Fluid Flow Branch chapter describes the Pipe Flow interface and the 
Non-Isothermal Pipe Flow interface including the underlying theory for these 
interfaces.

T H E  H E A T  TR A N S F E R  B R A N C H

The The Heat Transfer Branch chapter describes the Heat Transfer in Pipes interface 
and the underlying theory for the interface.

As detailed in the section Where Do I Access the Documentation and 
Model Library? this information is also searchable from the COMSOL 
Multiphysics software Help menu. Tip
O V E R V I E W  O F  T H E  U S E R ’ S  G U I D E  |  17
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 2
T h e  F l u i d  F l o w  B r a n c h
This chapter has information about the interfaces in the Pipe Flow Module 
available under the Fluid Flow branch ( ) in the Model Wizard. 

In this chapter:

• Mechanisms for Modeling Fluid Flow

• The Pipe Flow Interface

• The Non-Isothermal Pipe Flow Interface

• The Water Hammer Interface

• Theory for the Pipe Flow Interface

• Theory for the Water Hammer Interface
 19



20 |  C H A P T E R

pipe_ug.book  Page 20  Monday, April 23, 2012  5:04 PM
Mechan i sm s  f o r  Mode l i n g  F l u i d  F l ow

The Fluid Flow branch ( )has a number of subbranches to describe momentum 
transport. The main focus of this physics area is to model fluids transported in pipe 
networks in 2D and 3D space, calculating velocity, flow rate, and pressure drops. Pipe 
flow including heat and mass transfer can also be modeled.

The Pipe Flow interface ( ), found under the Single-Phase Flow branch ( ) in the 
Model Wizard, is used to model incompressible fluid flow in piping systems. The 
equations that are solved are 1D equations that live on 2D boundary segments or 3D 
edge segments. The Non-Isothermal Pipe Flow interface ( ), found under the 
Non-Isothermal Flow branch ( ) in the Model Wizard, solves a temperature equation 
together with the equations for incompressible flow. The Water Hammer 

interface ( ), found under the Fluid Flow>Single-Phase Flow branch ( ) in the 
Model Wizard, has the equations and boundary conditions for modeling rapid pressure 
transients in a pipe systems.

Coupling to Other Physics Interfaces

It is often be relevant to couple flow and transport in pipes or pipe networks to physical 
processes occurring outside the pipe network itself. For instance, liquid can be injected 
into the surrounding by means of perforated pipes. The Pipe Flow interface can 
calculate flow rates and pressure drops in a 1D representation in the injection system. 
The equations can then be coupled to a Fluid Flow interface describing fluid flow in 
2D or 3D geometries. Another important coupling that is prepared in the Pipe Flow 
module is the Wall Heat Transfer feature that couples the temperature in a pipe to the 
temperature in a 3D surrounding.

More advanced descriptions 2D and 3D continuum fluid flow, such as turbulent and 
multiphase flow, can be found in the CFD Module. More extensive descriptions of heat 
transfer, such as in turbulent flow or involving radiation, can be found in the Heat 
Transfer Module. Furthermore, some applications involving the flow of liquids and 
gases in porous media are better handled by the Chemical Reaction Engineering 
Module.
 2 :  T H E  F L U I D  F L O W  B R A N C H
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Th e  P i p e  F l ow I n t e r f a c e  

The Pipe Flow interface ( ), found under the Single-Phase Flow branch ( ) in the 
Model Wizard, has the equations, boundary conditions, and volume forces for modeling 
incompressible fluid flow in one dimension. 

When this interface is added, these default nodes are also added to the Model Builder—
Fluid Properties, Pipe Properties, Pressure, and Initial Values. Right-click the Pipe Flow 
node to add other features that implement, for example, boundary conditions and 
volume forces.

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is pfl.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list. 

• Discharging Tank: Model Library path 
Pipe_Flow_Module/Tutorial_Models/discharging_tank

• Convective Flow in a Heat Exchanger Plate: Model Library path 
Pipe_Flow_Module/Heat_Transfer/heat_exchanger_plate

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

Model

2D

3D
T H E  P I P E  F L O W  I N T E R F A C E  |  21
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D E P E N D E N T  V A R I A B L E S

This interface defines these dependent variables (fields). If required, edit the name, but 
dependent variables must be unique within a model:

• Pressure p (SI unit: Pa)

• Tangential velocity u (SI unit: m/s)

For an explanation of the tangential velocity, see further in the section Theory for the 
Pipe Flow Interface.

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

Select discretization options from the Pressure and Tangential velocity lists—Quadratic 
(the default), Linear, Cubic, or Quartic.

For each Dependent variable in the table under Value types when using splitting of 

complex variables, choose either a Complex or Real Value type. Click the cell to select 
from a drop-down list.

Edge, Boundary, Point, and Pair Features for the Pipe Flow Interface 

The Pipe Flow Interface has these boundary, edge, point, and pair features available 
and listed in alphabetical order: 

• Bend

• Contraction / Expansion

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Pipe Flow Interface

• Theory for the Pipe Flow InterfaceSee Also

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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• Initial Values

• Inlet

• No Flow

• Outlet

• Pipe Properties

• Pressure

• Pump

• T-Junction

• Valve 

These features are described for the Laminar Flow interface in the COMSOL 
Multiphysics User’s Guide:

• Fluid Properties

• Volume Force

Pipe Properties

The Pipe Properties node is used to define the pipe shape, flow resistance, and surface 
roughness.

For this interface, apply the Fluid Properties and Volume Force node to 
Edges (3D models) and Boundaries (2D models) instead of Domains.

In the COMSOL Multiphysics User’s Guide:

• Continuity on Interior Boundaries

• Identity and Contact Pairs 

• Specifying Boundary Conditions for Identity Pairs

Note

See Also
T H E  P I P E  F L O W  I N T E R F A C E  |  23
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E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the pipe properties.

P I P E  S H A P E

Select a pipe shape from the list—Not set (the default), Round, Square, Rectangular, or 
User defined.

• If Round is selected, enter a value or expression for the Inner diameter di (SI unit: 
m). The default is 10 cm.

• If Square is selected, enter a value or expression for the Inner width wi (SI unit: m). 
The default is 5 cm.

• If Rectangular is selected, enter a value or expression for the Inner width wi (SI 
unit: m. The default is 5 cm) and Inner height hi (SI unit: m. The default is 10cm).

• If User defined is selected, enter a value or expression for the Cross sectional area Ac 
(SI unit: m2. The default is 0.01 m2) and Wetted perimeter Z (SI unit: m. The 
default is 0.4 m).

F L O W  R E S I S T A N C E

Select a Friction model

Newtonian fluids
Select—Churchill (the default), Stokes, Wood, Haaland, Colebrook, Von Karman, 
Swamee-Jain, or User defined.

• If Churchill, Wood, Haaland, Von Karman, or Swamee-Jain is selected, go to the Surface 
Roughness section to select from a list of predefined values. Alternatively, enter 
values or expressions.

• If User defined is selected, enter a value or expression for the Darcy friction factor fD 
(unitless).

Non-Newtonian fluids
For Power-law and Bingham fluids in round tubes, the Irvine, Stokes, and Darby friction 
models are available.

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note
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For more information about the friction models, please refer to the theory section 
Expressions for the Darcy Friction Factor.

S U R F A C E  R O U G H N E S S

Select a Surface roughness from the list—Drawn tubing (0.0015 mm) (the default), Glass 
(0.0015 mm), Thermoplastics (0.0015 mm), Commercial steel (0.046 mm), Wrought iron 

(0.046 mm), Steel welded seamless (0.061 mm), Asphalted cast iron (0.12 mm), Galvanized 

iron (0.15 mm), Cast iron (0.26 mm), Wood stave (0.5 mm), Copper and brass (0.61 mm), 
Concrete (1.5 mm), Riveted steel (4.5 mm), or User defined.

• If User defined is selected, enter a value or expression for the Roughness (SI unit: m).

Initial Values 

The Initial Values feature adds initial values for the pressure and tangential velocity that 
can serve as an initial condition for a transient simulation or as an initial guess for a 
nonlinear solver.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define initial values. 

I N I T I A L  V A L U E S

Enter values or expressions for the initial value of the Pressure p (SI unit: Pa) and the 
Tangential Velocity u (SI unit: m/s). 

This section is available if Churchill, Wood, Haaland, Von Karman, or 
Swamee-Jain is selected as the Friction model.

Note
T H E  P I P E  F L O W  I N T E R F A C E  |  25
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Inlet

Use the Inlet node to set the velocity, volumetric flow rate, or mass flow rate inlet 
conditions that describe the fluid flow condition at an inlet. 

PO I N T  S E L E C T I O N

From the Selection list, choose the points that represent inlets.

I N L E T  S P E C I F I C A T I O N

Select a Specification for the inlet—Mass flow rate (the default), Velocity, or Volumetric 

flow rate.

• If Mass flow rate is selected, enter a value or expression for the Mass flow rate qm,0 
(SI unit: kg/s). The default is 0.

• If Velocity is selected, enter a value or expression for the Velocity u0 (SI unit: m/s). 
The default is 0.

• If Volumetric flow rate is selected, enter a value or expression for the Volumetric flow 

rate qv,0 (SI unit: m3/s). The default is 0.

Outlet

Use the Outlet node to set the velocity, volumetric flow rate, or mass flow rate point 
conditions that describe the fluid flow condition at an outlet. 

In most cases the inlet boundary conditions appear, some of them slightly 
modified, in the Outlet type as well. This means that there is nothing in 
the mathematical formulations to prevent a fluid from leaving the domain 
through boundaries where the Inlet type is specified.

Tip

See Inlet for all settings.

Note
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No Flow

Use the No Flow node to define plugged exits or inlets (no flow).

PO I N T  S E L E C T I O N

From the Selection list, choose the points that represent no flow.

Pressure

Use the Pressure node to define the boundary pressure at points.

PO I N T  S E L E C T I O N

When additional nodes are added, from the Selection list choose the points that 
represent the pressure.

B O U N D A R Y  P R E S S U R E

Enter a value or expression for the Pressure p0 (SI unit: Pa). The default is 101325 Pa.

All of the formulations for the Outlet type are also available, possibly 
slightly modified, in other boundary types as well. This means that there 
is nothing in the mathematical formulations to prevent a fluid from 
entering the domain through boundaries where the Outlet boundary type 
is specified.

Tip

The pressure condition can only be applied to a point which is connected 
to exactly one edge (inlet or outlet of a system).

Note

For the default node no user selection is required. All points is 
automatically selected.

Note
T H E  P I P E  F L O W  I N T E R F A C E  |  27
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C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Select a Constraint type—Bidirectional, symmetric or Unidirectional. If required, select 
the Use weak constraints check box.

Bend

Use the Bend node to introduce a pressure drop in a point associated with a bend in 
the pipe system.

PO I N T  S E L E C T I O N

From the Selection list, choose the points that represent the bend.

B E N D  S P E C I F I C A T I O N

Select a Bend—90 degrees standard elbow (K = 0.9) (the default), 45 degrees standard 

elbow (K = 0.5), or User specified loss coefficient. If User specified loss coefficient is 
selected, also enter a Loss coefficient Kf (unitless).

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box.

The Bend can only be applied to a point which is connected to exactly two 
edges.

Note
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Valve

Use the Valve node to introduce a pressure drop in a point associated with the position 
of a valve in the pipe system. Select a predefined valve type or provide a user defined 
loss coefficient.

PO I N T  S E L E C T I O N

From the Selection list, choose the points for the valve.

VA L V E  S P E C I F I C A T I O N

Select a Valve—Globe valve (K = 10) (the default), Angle valve (K = 4.4), Gate valve (K = 

0.2), Ball valve (K = 4.5), Butterfly valve (K = 0.6), Swing check (K = 2.5), or User specified 

loss coefficient. For all selections, enter values or expressions for the First edge i and 
Second edge j (unitless numbers). If User specified loss coefficient is selected, also enter 
a Loss coefficient Kf (unitless).

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box. 

Contraction / Expansion

Use the Contraction/Expansion node to introduce a pressure drop in a point associated 
with the position of a contraction or expansion in the pipe system.

The Valve can only be applied to a point which is connected to exactly two 
edges.

Note

The Contraction/Expansion can only be applied to a point which is 
connected to exactly two edges.

Note
T H E  P I P E  F L O W  I N T E R F A C E  |  29
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PO I N T  S E L E C T I O N

From the Selection list, choose the points for the contraction.

C O N T R A C T I O N  S P E C I F I C A T I O N

Select an option from the Friction list—Sudden (the default), Gradual, or User specified 

loss coefficient. 

• If Gradual is selected, also enter an Angle of convergence  (SI unit: radians). The 
default is 0.

• If User specified loss coefficient is selected, also enter a Loss coefficient Kf (unitless). 
The default is 0.

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box. 

Pump

Use the Pump node to introduce a pressure jump in a point associated with the position 
of a pump in the pipe system. Alternatively, specify a fixed mass flow rate for the pump.

PO I N T  S E L E C T I O N

From the Selection list, choose the points for the pump.

P U M P  S P E C I F I C A T I O N

Select a Pump direction (available options are based on space dimension)—Positive X 

direction (the default), Negative X direction, Positive Y direction, Negative Y direction, 
Positive Z direction, or Negative Z direction. 

C

The Pump can only be applied to a point which is connected to exactly 
two edges.

Note
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Select an option from the Type list—Fixed flow rate (the default), Downstream pressure, 
or Pressure increase.

• If Fixed flow rate is selected, also enter a value or expression for the Mass flow rate 
mpump (SI unit: kg/s). The default is 0.

• If Downstream pressure is selected, also enter a value or expression for the Pressure 
pdown (SI unit: Pa). The default is 101 325 Pa.

• If Pressure increase is selected, also enter a value or expression for the Pressure 

increase p (SI unit: Pa). The default is 0.

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box. 

T-Junction

Use the T-Junction node to specify the friction coefficients for a T-junction, which can 
act as a split or a merger. The pressure drop is calculated according to Equation 2-9.

Figure 2-1: A T-junction with local pressure indications.

PO I N T  S E L E C T I O N

From the Selection list, choose the points for the T-junction.

F R I C T I O N  S P E C I F I C A T I O N

Enter a value or expression for the Loss coefficient main branch Kf,main for the loss 
between main and junction pressure (the default is 0.1) and the Loss coefficient side 

pmain

pjunction

pmain

pside

The T-junction can only be applied to a point that is connected to exactly 
two collinear main branches and one perpendicular side branch. The flow 
can go in either direction through each of the main branches and the side 
branch. See Figure 2-1.Note
T H E  P I P E  F L O W  I N T E R F A C E  |  31
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branch Kf, side
for the loss between the side pressure and junction pressure (the default 

is 1.2). Both are unitless numbers. See Figure 2-1.

The respective pressure drops are calculated as

 (2-1)

.  (2-2)

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box. 

pmain pjunction–
1
2
---Kf main umain

2
=

pside pjunction–
1
2
---Kf side uside

2
=
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Th e  Non - I s o t h e rma l  P i p e  F l ow 
I n t e r f a c e

The Non-Isothermal Pipe Flow interface ( ), found under the Non-Isothermal Flow 

branch ( ) in the Model Wizard, has the equations, boundary conditions, and volume 
forces for modeling incompressible fluid flow and heat transfer in pipes.

When this interface is added, these default nodes are also added to the Model Builder—
Fluid, Pipe Properties, Pressure, Temperature, and Initial Values. Right-click the 
Non-Isothermal Pipe Flow node to add other features that implement, for example, 
boundary conditions and volume forces. 

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is nipfl.

• Insulation of a Pipeline Section: Model Library path 
Pipe_Flow_Module/Heat_Transfer/pipeline_insulation

• Geothermal Heating from a Pond Loop: Model Library path 
Pipe_Flow_Module/Heat_Transfer/geothermal_heating

• Cooling of an Injection Mold: Model Library path 
Pipe_Flow_Module/Heat_Transfer/mold_cooling

 

The interface is available in 3D on edges and 2D on boundaries.

Model

2D

3D
T H E  N O N - I S O T H E R M A L  P I P E  F L O W  I N T E R F A C E  |  33



34 |  C H A P T E R

pipe_ug.book  Page 34  Monday, April 23, 2012  5:04 PM
E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list. 

F L U I D  M O D E L

Select a Fluid model—Newtonian (the default), Power law, or Bingham.

D E P E N D E N T  V A R I A B L E S

This interface defines these dependent variables (fields). If required, edit the name, but 
dependent variables must be unique within a model:

• Pressure p (SI unit: Pa)

• Tangential velocity u (SI unit: m/s)

• Temperature T (SI unit: K)

For an explanation of the tangential velocity, see further in the section Theory for the 
Pipe Flow Interface.

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

Select discretization options from the Pressure and Tangential velocity lists—Quadratic 
(the default), Linear, Cubic, or Quartic.

For each Dependent variable in the table under Value types when using splitting of 

complex variables, choose either a Complex or Real Value type. Click the cell to select 
from a drop-down list.

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Non-Isothermal Pipe 
Flow Interface

• Theory for the Pipe Flow Interface

• Theory for the Heat Transfer in Pipes Interface

See Also
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Edge, Boundary, Point, and Pair Features for the Non-Isothermal 
Pipe Flow Interface 

Because The Non-Isothermal Pipe Flow Interface is a multiphysics interface, it shares 
many features with other interfaces. These boundary, edge, point, and pair features are 
available as indicated (and listed in alphabetical order).

The Fluid node and Heat Transfer are described in this section.

These features are described for the Reacting Pipe Flow interface:

• Fluid Properties

• Pipe Properties

These features are described for the Heat Transfer in Pipes interface:

• External Film Resistance

• Internal Film Resistance

• Wall Heat Transfer

• Wall Layer

These features are described for the Heat Transfer interface in the COMSOL 
Multiphysics User’s Guide:

• Heat Source

• Outflow

• Temperature

These features are described for the Pipe Flow interface (listed in alphabetical order):

• Bend

• Contraction / Expansion

• Inlet

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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• No Flow

• Outlet

• Pressure

• Pump

• T-Junction

• Valve

Fluid

Use the Fluid node to define the density, dynamic viscosity, and heat convection and 
conduction properties.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the fluid.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) is User defined and is 1 x 103 kg/m3. Enter a 
different value or expression as required. 

Enter a value or expression for the Yield stress s (SI unit: Pa) and Plastic viscosity s 
(SI unit: Pa·s). The defaults are 0.

In the COMSOL Multiphysics User’s Guide:

• Volume Force is described for the Laminar Flow interface

• Continuity on Interior Boundaries

• Identity and Contact Pairs 

• Specifying Boundary Conditions for Identity Pairs

See Also

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note
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H E A T  C O N V E C T I O N  A N D  C O N D U C T I O N  

The default Heat capacity at constant pressure Cp (SI unit: J/(kg·K)), Ratio of specific 

heats  (unitless), and Thermal conductivity k (SI unit: W/(m·K)) all use values From 

material. If User defined is selected, enter different values or expressions.

Heat Transfer

Use the Heat Transfer node to define the density, yield stress, plastic viscosity, and heat 
convection and conduction properties. 

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to apply the heat transfer 
properties. 

M O D E L  I N P U T S

This section contain fields and values that are inputs to expressions that define material 
properties. If such user-defined material models are added, the model inputs appear 
here. Initially, this section is empty.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) is User defined and is 1 x 103 kg/m3. Enter a 
different value or expression as required. 

Enter a value or expression for the Yield stress s (SI unit: Pa) and Plastic viscosity s 
(SI unit: Pa·s). The defaults are 0.

H E A T  C O N V E C T I O N  A N D  C O N D U C T I O N  

The default Heat capacity at constant pressure Cp (SI unit: J/(kg·K)), Ratio of specific 

heats  (unitless), and Thermal conductivity k (SI unit: W/(m·K)) all use values From 

material. If User defined is selected, enter different values or expressions.
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Th e  Wa t e r  Hamme r  I n t e r f a c e

The Water Hammer interface ( ), found under the Fluid Flow>Single-Phase Flow 

branch ( ) in the Model Wizard, has the equations and boundary conditions for 
modeling rapid pressure transients in a pipe systems.

When this interface is added, these default nodes are also added to the Model Builder—
Fluid Properties, Pipe Properties, Closed, and Initial Values. Right-click the Water 

Hammer node to add other features.

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is whtd.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list. 

D E P E N D E N T  V A R I A B L E S

This interface defines these dependent variables (fields). If required, edit the name, but 
dependent variables must be unique within a model:

• Pressure p (SI unit: Pa)

• Tangential velocity u (SI unit: m/s)

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

Water Hammer: Model Library path 
Pipe_Flow_Module/Verification_Models/water_hammer_verification

Model
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Select discretization options from the Pressure and Tangential velocity lists—Quadratic 
(the default), Linear, Cubic, or Quartic.

For each Dependent variable in the table under Value types when using splitting of 

complex variables, choose either a Complex or Real Value type. Click the cell to select 
from a drop-down list.

Edge, Boundary, Point, and Pair Features for the Water Hammer 
Interface 

The Water Hammer Interface has these edge, boundary, point, and pair features 
available and listed in alphabetical order:

• Closed

• Fluid Properties

• Local Friction Loss

• Pipe Properties

• Pressure

• Velocity

The Initial Values node is described for the Pipe Flow interface.

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Water Hammer 
Interface

• Theory for the Pipe Flow Interface
See Also

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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Fluid Properties

The Fluid Properties feature adds the momentum equations solved by the interface, 
except for volume forces which are added by the Volume Force feature. The node also 
provides an interface for defining the physical properties of the fluid.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to apply the fluid properties. 

M O D E L  I N P U T S

Edit input variables to the fluid-flow equations if required. For fluid flow, these are 
typically introduced when a material requiring inputs has been applied.

P H Y S I C A L  P R O P E R T I E S

Select a Fluid model—Linear elastic (the default).

The default Density  (SI unit: kg/m3) uses the value From material. Select User defined 
to enter a different value or expression. 

The default Dynamic viscosity  (SI unit: Pa·s) uses the value From material and 
describes the relationship between the shear rate and the shear stresses in a fluid. 
Intuitively, water and air have a low viscosity, and substances often described as thick 
(such as oil) have a higher viscosity.

In the COMSOL Multiphysics User’s Guide:

• Volume Force is described for the Laminar Flow interface

• Continuity on Interior Boundaries

• Identity and Contact Pairs 

• Specifying Boundary Conditions for Identity Pairs

See Also

Volume Force is described for the Laminar Flow interface in the COMSOL 
Multiphysics User’s Guide:

Note
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The default Speed of sound cs (SI unit: m/s) uses the value From material. Select User 

defined to enter a different value or expression.

Pipe Properties

The Pipe Properties node is used to define the pipe shape, pipe model, and flow 
resistance.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the pipe properties.

P I P E  S H A P E

P I P E  M O D E L

Select a Pipe model—Zero axial stress (the default), Anchored at one end, Anchored at 

both ends, or Incompressible cross section.

• If Zero axial stress is selected, select a Young’s modulus E—Not set (the default) or 
User defined. If User defined is selected, enter a value or expression.

• If Anchored at one end or Anchored at both ends is selected, enter a value or 
expression for the Young’s modulus E. Select a Poisson’s ratio v—Not set (the default) 
or User defined. If User defined is selected, enter a value or expression.

When Zero axial stress, Anchored at one end, or Anchored at both ends is selected, also 
select a Wall thickness w—Not set (the default) or User defined. If User defined is 
selected, enter a value or expression.

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note

The Pipe Shape settings are the same as for the Pipe Properties node 
described for the Pipe Flow interface.

Note


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F L O W  R E S I S T A N C E

Local Friction Loss

Use the Local Friction Loss feature to add a lumped friction loss that depends on the 
velocity according to Equation 2-9.

PO I N T  S E L E C T I O N

From the Selection list, choose the local friction loss points.

F R I C T I O N  S P E C I F I C A T I O N

Enter a Loss coefficient Kf (unitless). The default is 0.

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Select a Constraint type—Bidirectional, symmetric or Unidirectional. If required, select 
the Use weak constraints check box.

Closed

Use the Closed feature to impose zero velocity.

PO I N T  S E L E C T I O N

From the Selection list, choose the closed points.

Velocity

Use the Velocity feature to prescribe a velocity.

PO I N T  S E L E C T I O N

From the Selection list, choose the velocity points.

VE L O C I T Y

Enter a value or expression for uin (SI unit: m/s). The default is 0.

The Flow Resistance settings are the same as for the Pipe Properties node 
described for the Pipe Flow interface.

Note
 2 :  T H E  F L U I D  F L O W  B R A N C H



pipe_ug.book  Page 43  Monday, April 23, 2012  5:04 PM
Pressure

Use the Pressure node to define the boundary pressure at points.

PO I N T  S E L E C T I O N

From the Selection list, choose the pressure points.

P R E S S U R E

Enter a value or expression for the Pressure p (SI unit: Pa).

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Select a Constraint type—Bidirectional, symmetric or Unidirectional. If required, select 
the Use weak constraints check box.
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Th eo r y  f o r  t h e  P i p e  F l ow I n t e r f a c e

The Pipe Flow Interface theory is described in this section:

• Flow Equations

• References for the Pipe Flow Interface

Flow Equations

The Pipe Flow interface calculates the pressure and velocity of an incompressible fluid 
by solving the continuity and momentum equations outlined below.

A one dimensional pipe can be present on a boundary in a 2D geometry, or on an edge 
in a 3D geometry.

M O M E N T U M  A N D  C O N T I N U I T Y  E Q U A T I O N S

The momentum and continuity equations for flow in a pipe are given by (Ref. 16):

 (2-3)

and

 (2-4)

The second term on the right hand side in Equation 2-3 represents the pressure drop 
due to viscous shear. Here, u is the cross section averaged velocity (m/s),  the density 
(kg/m3), p pressure (Pa), fD (dimensionless) the Darcy friction factor (see Expressions 
for the Darcy Friction Factor) and F is a volume force term (N/m3). 

Furthermore, dh is the mean hydraulic diameter (m), given by:

 (2-5)

u
t
------- p– fD


2dh
----------u u– F+=

A
t

-----------  Au + 0=

dh
4A
Z

-------=
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where A is the pipe cross section area (m2) available for flow, and Z is the wetted 
perimeter (m).

Figure 2-2: Unit tangent vector to the pipe axis.

Let

be the unit tangent vector to the pipe axis. Since all the velocity components normal 
to the pipe axis is assumed to be 0, the momentum balance in Equation 2-3 can be 
rewritten as

 (2-6)

and we can define the tangential velocity u as . The Physics Pipe Flow in 
COMSOL solves for the tangential velocity u. This is also the quantity the user 
specifies in for example inflow boundary conditions.

The following assumptions apply:

• The velocity profile is fully developed and does not change within a section.

• The cross section area is allowed to change between pipe segments.

• Empirical functions describe viscous losses

• Shocks are neglected

• The flow direction is in the direction of the pipe axis.

The Darcy friction factor in Equation 2-3 accounts for the continuous pressure drop 
along a pipe segment due to viscous shear, and is expressed as a function of the 
Reynolds number (Re) and the surface roughness divided by the hydraulic diameter 
(e/dh).

 (2-7)

et

et et x et y et z 
 =

et u
t
------- p– fD


2dh
----------u u– F+=

u uet=

fD f= D Re e
dh
------ 

 
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where

 (2-8)

The physics interface automatically calculates fD from one of the predefined 
expressions Equation 2-10 through Equation 2-16.

Additional Flow Resistances
Additional flow resistances can be added as point conditions between pipe segments—
Bends, Valves, T-junctions, Contractions, and Expansions. These resistances give rise 
to abrupt (lumped) pressure drops in the points where they are added. The pressure 
drop is calculated as:

 (2-9)

Loss coefficients, Ki, for turbulent flow are available in the literature (Ref. 14) and the 
set predefined in the Pipe Flow interface is reproduced in the table below: 

TABLE 2-1:  LOSS COEFFICIENTS

FEATURE DESCRIPTION LOSS COEFFICIENT K

Bends 90° standard elbow 0.9

45° standard elbow 0.5

Valves Globe, fully open 10

Angle, fully open 4.4

Gate, fully open 0.2

Ball, fully open 4.5

Butterfly, fully open 0.6

Swing check, fully open 2.5

T-junction T-junction split/merger 0.1 and 2.1 for side and main. See 
Figure 2-1 for a description of flow 
branches in a T-junction.

Contractions Sudden

Gradual, angle of 
convergence < 22°

Gradual, angle of 
convergence > 22°

Expansions Sudden

Re
udh


--------------=

p 1
2
---Kfu2

=

0.5 1 2
– 

0.8   1 2
– sin

0.5 sin( 1 2
– 

1 2
– 

2
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Above,  is the ratio of small to large cross-sectional area. The point friction losses 
listed above apply for Newtonian fluids. Point losses applying to non-Newtonian flow 
can be added as user defined expressions, for instance from (Ref. 15).

Expressions for the Darcy Friction Factor

Newtonian Fluids   The Churchill equation (Ref. 1) for the Darcy friction factor can be 
used for the full range of Re (laminar, transition and turbulent) and e/d:

 (2-10)

where

 (2-11)

 (2-12)

In the laminar regime (Re < 2000), fD is independent of the surface roughness and is 
given by the Stokes formula:

 (2-13)

The Wood equation (Ref. 2) gives the friction factor for 4000 < Re <  1·107 and 
1·10-5 < e/d <  0.04, according to

 (2-14)

with

 (2-15)

Gradual, angle of 
convergence < 22°

Gradual, angle of 
convergence > 22°

TABLE 2-1:  LOSS COEFFICIENTS

FEATURE DESCRIPTION LOSS COEFFICIENT K

2.6   1 2
– 

2
sin

1 2
– 

2

fD 8 8
Re
------ 
  12

A B+ -1.5
+

1 12
=

A -2.457ln 7
Re
------ 
  0.9

0.27 e d + 
  16

=

B 37530
Re

---------------- 
  16

=

fD
64
Re
------=

fD 0.094 e d 0.225 0.53 e d  88 e d 0.44 Rea+ +=

a 1.62– e d 0.134
=
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The Haaland equation (Ref. 3) for the Darcy friction factor is commonly used for oil 
pipelines and wells. It can recover both small and large relative roughness limits for a 
wide range of Reynolds numbers (4·103 < Re < 1·108)

 (2-16)

It can be rewritten as

 (2-17)

For very low relative roughness e/d, the Haaland equation simplifies to Colebrook’s 
explicit formula (Ref. 4)

 (2-18)

For very large relative roughness e/d, the Haaland equation simplifies to the von 
Karman formula (Ref. 5)

 (2-19)

An alternative to Haaland equation is the Swamee-Jain equation (Ref. 6)

 (2-20)

The equation is valid for relative roughness 1·10-6 < e/d <  1·10-2 and for Reynolds 
number in the range 5·103 < Re <  1·108.

All the above equations are selectable from a list of friction factor expressions. As 
noted, only the Churchill equation covers both the laminar and turbulent flows, as well 
as the transitional region in between these flow regimes. The equations by Wood, 
Haaland, Colebrook, von Karman, or Swamee-Jain, intended for the turbulent regime, 
are combined with the Stokes equation for laminar flow to cover all flow conditions. 
When Re<1000, COMSOL selects Stokes equation if it predicts a friction factor 
greater than equations for the turbulent regimes. This produces more accurate results 
that using the turbulent frictions factors in the laminar regime, but it does not 

1
fD
----- 1.8log10

e d
3.7
---------- 
  1.11 6.9

Re
-------- 
 + 

 –=

fD
1 1.8 2

log10
e d
3.7
---------- 
  1.11 6.9

Re
-------- 
 + 

  2
--------------------------------------------------------------------=

1
fD
----- 1.8– log10

6.9
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-------- 
 =

1
fD
----- 1.8log10

e d
3.7
---------- 
 1.11

 
 – 2log10
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---------- 
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necessarily produce accurate estimates of the friction factor in the transition region. 
Therefore, it is always advisable to check the Reynolds number for a give pipe flow 
solution and change the friction model and recalculate, if necessary.

Non-Newtonian Power-law Fluids   For Power-law fluids the apparent viscosity is related 
to the shear rate as

 (2-21)

where m and n are two empirical curve fitting parameters known as the fluid 
consistency coefficient and the flow behavior index, respectively. In the laminar regime 
the friction factor for power law fluids can be calculated by the Stokes equation using 
the modified Reynolds number proposed by Metzner and Reed (Ref. 7):

 (2-22)

 (2-23)

For the turbulent regime Irvine (Ref. 8) proposed the following expression for the 
friction factor:

 (2-24)

where

 (2-25)

Ryan and Johnson (Ref. 9) formulated a criterion for the transition between laminar 
and turbulent flow, where

 (2-26)

predicts the critical Reynolds number.
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=
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Non-Newtonian Bingham Plastic Model.   The Bingham model describes viscoplastic 
fluid with a yield stress:

 (2-27)

The yield stress, B (Pa), and the plastic viscosity, B (Pa·s), are found by curve fitting 
to experimental data.

The Swamee-Aggarwal equation (Ref. 10) gives the friction factor for a Bingham 
plastic fluid in the laminar regime according to:

 (2-28)

where

 (2-29)

and

 (2-30)

is the Hedström number.

For turbulent flow Darby (Ref. 11) provided the equation:

 (2-31)

with

 (2-32)

as well as an equation covering all flow regimes:

 B B

t
----- 
 += for  B


t
----- 
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ReB
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 (2-33)

where

 (2-34)

The non-Newtonian friction models outlined above apply for pipes with circular 
cross-section. The generalized Reynolds number needs to be modified to account for 
other cross-sections.

Surface Roughness
Values of the absolute surface roughness found in the literature (Ref. 13 and Ref. 14) 
are reproduced in the table below:

fD fD, laminar
b fD, turbulent

b
+ 

1
b
---

=

b 1.7 40000
ReB

----------------+=

The non-Newtonian friction models outlined above do not include any 
effects of wall roughness. As the laminar sub-layers tend to be thicker than 
for Newtonian fluids, the effect of pipe roughness is likely to be smaller. 
Friction models including the surface roughness can be used as 
user-defined specifications and can be found in for example (Ref. 12).

Note

TABLE 2-2:  SURFACE ROUGHNESS

TUBE MATERIAL SURFACE 
ROUGHNESS (MM)

Drawn tubing 0.0015

Glass 0.0015

Thermoplastics 0.0015

Commercial steel 
and wrought iron

0.046

Steel, welded 
seamless

0.061

Asphalted cast 
iron

0.12

Galvanized iron 0.15

Cast-iron 0.26

Wood stave 0.18-0.9
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References for the Pipe Flow Interface
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Th eo r y  f o r  t h e  Wa t e r  Hamme r  
I n t e r f a c e

Flow Equations

The Water Hammer interface implements both the continuity equation and the 
momentum equations for a compressible fluid travelling inside pipes of variable cross 
section.

T H E  C O N T I N U I T Y  E Q U A T I O N

The mass conservation for a fluid inside a pipe is given by:

 (2-35)

where A (SI unit: m2) is the cross section area of the pipe,  (SI unit: kg/m3) is the 
fluid density, and u (SI unit: m/s) is the tangential fluid velocity.

For isothermal processes, the density and cross section area are function of the 
pressure, so the continuity equation reads

 (2-36)

In a first order approximation, this equals

 (2-37)

where K is the bulk modulus of the fluid (the inverse of its compressibility), and KA 
is the effective bulk modulus of the cross section area. A0 and 0 are the reference area 
and reference density at a given pressure p0.

The Water Hammer wave speed c (SI unit: m/s) is given by a combination of fluid and 
structural material properties

 (2-38)

The effective bulk modulus for the cross sectional area KA (SI unit: Pa) is given by the 
pipe’s material properties
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where E is the Young’s modulus, dh is the hydraulic diameter, and wth is the pipe’s 
wall thickness. This is the so-called Korteweg formula (Ref. 1)

The Korteweg formula can also be extended to pipes suffering from axial stresses, in 
this case, a more general formula would include the Poisson’s ration  of the pipe’s 
material

 (2-39)

where  for pipe with zero axial stress (this is Korteweg’s original formula for a 
pipe furbished with expansion joints),  for a pipe anchored at one end, 
and  for a pipe anchored at both ends.

T H E  M O M E N T U M  E Q U A T I O N

The momentum equation is written as:

 (2-40)

here, fD is the Darcy friction factor, normally a function of the Reynolds number, the 
surface roughness and the hydraulic diameter, as described in Expressions for the 
Darcy Friction Factor.

This set of equations are normally acknowledged as the Water Hammer equations, and 
are they mainly written in the literature as (consider gravity forces, so )

 (2-41)

 (2-42)

B O U N D A R Y  C O N D I T I O N S

The available boundary conditions are Closed, Pressure, Velocity, and Additional Flow 
Resistances.
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References for the Water Hammer interface
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 3
T h e  H e a t  T r a n s f e r  B r a n c h
This physics, which is found under the Heat Transfer branch ( ) in the Model 

Wizard, has functionality for simulating heat transfer in pipe networks, including 
wall heat transfer to the surroundings.

In this chapter:

• The Mechanisms for Heat Transfer

• The Heat Transfer in Pipes Interface

• Theory for the Heat Transfer in Pipes Interface
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Th e  Me chan i sm s  f o r  Hea t  T r a n s f e r

The Heat Transfer branch ( ) includes a number of subbranches to describe energy 
transport. One or more of them can be added from the Model Wizard.

The Heat Transfer in Pipes interface ( ), found under the Heat Transfer branch ( ) 
in the Model Wizard, solves a temperature equation for a fluid transported in a pipe. The 
interface requires the fluid velocity as input, provided either by the user or by coupling 
to the Pipe Flow interface. However, it is advisable to instead use The Non-Isothermal 
Pipe Flow Interface which is a multiphysics interface that combines Pipe Flow and 
Heat Transfer in Pipes to model the velocity, pressure and temperature fully coupled.

Coupling to Other Physics Interfaces

It is often relevant to couple heat transport in pipe networks to heat transfer in the 
region surrounding the pipe network. Simulating the cooling of a mold is a good 
example of such an application (see mold_cooling above). The Heat Transfer in Pipes 
physics or the Non-Isothermal Pipe Flow interface can be used to model the removal 
of heat in the cooling channels represented by 1D edges, and couple that heat loss to 
a 3D model of the mold. The pipe heat model is automatically coupled to the 3D 
surroundings.

The Heat Transfer in Solids, Heat Transfer in Fluids (general convection 
and conduction, non-isothermal flow, and conjugate heat transfer), and 
Joule Heating interfaces all belong to the COMSOL Multiphysics base 
package. See The Heat Transfer Interface, The Joule Heating Interface 
and Theory for the Heat Transfer Interfaces in the COMSOL 
Multiphysics User’s Guide for more information.

Note

• Insulation of a Pipeline Section: Model Library path Pipe_Flow_Module/

Heat_Transfer/pipeline_insulation

• Geothermal Heating from a Pond Loop: Model Library path 
Pipe_Flow_Module/Heat_Transfer/geothermal_heating

• Cooling of an Injection Mold: Model Library path Pipe_Flow_Module/

Heat_Transfer/mold_cooling

Model
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More extensive descriptions of heat transfer, such as 3D turbulent flow models or 
problems involving surface-to-surface radiation, can be found in the Heat Transfer 
Module. Furthermore, some cases that involve geothermal applications with 
goundflow models for porous media are better handled by the Subsurface Flow 
Module.
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Th e  Hea t  T r a n s f e r  i n  P i p e s  I n t e r f a c e

The Heat Transfer in Pipes interface ( ), found under the Heat Transfer branch ( ) 
in the Model Wizard, has the equations and boundary conditions for modeling heat 
transfer for an incompressible fluid in one dimension. 

When this interface is added, these default nodes are also added to the Model Builder—
Heat Transfer, Pipe Properties, Temperature, and Initial Values. Right-click the Heat 

Transfer in Pipes node to add other features.

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is htp.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list.

D E P E N D E N T  V A R I A B L E S

This interface defines the Temperature T (SI unit: K) dependent variable (field). If 
required, edit the name, but dependent variables must be unique within a model.

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

 

The Heat Transfer in Pipes interface is available in 3D on edges and 
points, and in 2D on boundaries and points.

2D

3D
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Select an option from the Temperature list—Quadratic (the default), Linear, Cubic, or 
Quartic. Specify the Value type when using splitting of complex variables—Real or 
Complex (the default).

Edge, Boundary, Point, and Pair Features for the Heat Transfer in 
Pipes Interface 

The Heat Transfer in Pipes Interface has these boundary, edge, point, and pair features 
available and listed in alphabetical order: 

• Heat Outflow

• Heat Source

• Heat Transfer

• Initial Values

• Pipe Properties (described for the Pipe Flow interface)

• Temperature

• Wall Heat Transfer

Heat Transfer

Use the Heat Transfer node to define the tangential velocity, density, dynamic viscosity, 
and heat convection and conduction properties. 

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Heat Transfer in 
Pipes Interface

• Theory for the Heat Transfer in Pipes Interface
See Also

 

This interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to apply the heat transfer 
properties. 

M O D E L  I N P U T S

This section contain fields and values that are inputs to expressions that define material 
properties. If such user-defined material models are added, the model inputs appear 
here. Initially, this section is empty.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) uses the value From material. Select User defined 
to enter a different value or expression. 

The default Dynamic viscosity  (SI unit: Pa·s) uses the value From material and 
describes the relationship between the shear rate and the shear stresses in a fluid. 
Intuitively, water and air have a low viscosity, and substances often described as thick 
(such as oil) have a higher viscosity.

H E A T  C O N V E C T I O N  A N D  C O N D U C T I O N

Select an option from the Tangential velocity list—User defined, Tangential velocity (nipfl/

nipfl), or Tangential velocity (pfl/pfl). If User defined is selected, enter a value for the 
Tangential velocity u (SI unit: m/s).

The default Density  (SI unit: kg/m3), Dynamic viscosity (SI unit: Pa·s), Heat capacity 

at constant pressure Cp (SI unit: J/(kg·K)), Ratio of specific heats  (unitless), and 
Thermal conductivity k (SI unit: W/(m·K)) all use values From material. If User defined 
is selected, enter different values or expressions.

Heat Source

The Heat Source describes heat generation within the domain. Express heating and 
cooling with positive and negative values, respectively. Add one or more nodes as 
required—all heat sources within a domain contribute to the total heat source. Specify 
the heat source as W/m in the domain, as linear heat source.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to add the heat source.
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H E A T  S O U R C E

Click the General source or Linear source button.

• If General source is selected, enter a value for the distributed heat source Q 
(SI unit: W/m3).

• If Linear source (Qqs·T) is selected, enter the Linear heat source qs (SI unit: W/
(m3·K)).

Wall Heat Transfer

Use the Wall Heat Transfer node to set up heat exchange across the pipe wall. Define 
the external temperature and the nature of the heat transfer. Right-click to add Internal 
Film Resistance, Wall Layer, and External Film Resistance sub features. These compute 
heat transfer coefficients based on the section Theory for the Heat Transfer in Pipes 
Interface. 

The advantage of writing the source in this form is that it can be stabilized 
by the streamline diffusion. The theory covers qs that is independent of 
the temperature, but some stability can be gained as long as qs is only 
weakly dependent on the temperature.

Stabilization Techniques in the COMSOL Multiphysics Reference Guide

Tip

See Also

You must add at least an Internal Film Resistance subnode. This 
corresponds to a drilled channel in a solid. If a pipe wall exists, (pipe 
embedded in a solid), add also Wall Layer. If the pipe wall has more than 
one layer, add more Wall Layer features. If the pipe exchanges heat to a 
surroundings fluid by forced or natural convection, add also External 
Film Resistance.

Note
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Figure 3-1: Internal and external films and the associated film coefficients (blue), and 
wall layers (dark and light grey).

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to apply the wall heat transfer 
properties. 

H E A T  TR A N S F E R  M O D E L

Select an option from the External temperature list—User defined, Temperature (nipfl/

nipfl), or Temperature (pfl/pfl). If User defined is selected, enter a value for the 
Temperature Text (SI unit: K).

Enter a value or expression for the Heat transfer coefficient h (SI unit: W/(m2·K). The 
default is 0. 

Internal Film Resistance

Right-click the Wall Heat Transfer node to add the Internal Film Resistance node and 
define the film resistance.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define the internal film 
resistance.

Wall layers

External filmInternal film

Even if you do not expect a boundary layer to build up, the thermal film 
theory works well for laminar flow profiles. In fact, there is an analytical 
solution available to the Nusselt number for laminar flow in circular tubes 
(Nu = 3.66).Note
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F I L M  R E S I S T A N C E

The default Internal film resistance model is Automatic and the Nusselt number is 
computed as described in the section Theory for the Heat Transfer in Pipes Interface. 
Select User defined to enter a user defined Nusselt number (unitless). The default is 3.66.

External Film Resistance

Right-click the Wall Heat Transfer node to add the External Film Resistance node and 
define the external film resistance features including the material, thermal conductivity, 
density, external velocity, and pressure of the external fluid. You can select between 
forced and natural convection.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define the external film 
resistance.

S P E C I F I C A T I O N

Select an External film heat transfer model—External forced convection (the default), 
External natural convection, or User defined. 

External Forced Convection and External Natural Convection
If External forced convection or External natural convection is selected, the External 

material uses the Domain material by default.

The default Heat capacity at constant pressure Cp (SI unit: J/(kg·K)), Thermal 

conductivity k (SI unit: W/(m·K)), Density  (SI unit: kg/m3), and Dynamic viscosity 
(SI unit: Pa·s), all use values From material. If User defined is selected, enter different 
values or expressions than the default, which is 0 for all options.

The External velocity uext (SI unit: m/s) is User defined by default. This is the velocity 
of the cooling or heating fluid outside the pipe.

For External natural convection only, also enter a value or expression for the External 

pressure pext (SI unit: Pa). The default is 1 atm.

Be careful to select the right material in the settings window for External 
Film Resistance. Many times this should be another material than the 
Domain material which is the internal fluid.Caution
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Figure 3-2: Before you use the Natural Convection option, it is good practice to select 
Density in the used material, and click Plot in the settings window. That way you can 
inspect the behavior and make sure it is smooth within the temperature interval you plan 
to use it.

User Defined
If User defined is selected:

• Enter the Nusselt number (unitless). The default is 3.66. 

• The External material uses the Domain material by default

• The Thermal conductivity k (SI unit: W/(m·K)) takes its value From material. Select 
User defined to enter a different value or expression. The default is 0.

• Enter a value or expression for the External pressure pext (SI unit: Pa). The default 
is 1 atm).

Wall Layer

Right-click the Wall Heat Transfer node to add the Wall Layer node and define the 
thermal conductivity and wall thickness. You can add more layers.

The natural convection correlations (see External film resistance) require 
a temperature dependent density, or else the coefficient of thermal 
expansion  evaluates to 0 (Equation 3-25), which may generate 
unexpected results or even unstable models. Also, make sure that the 
density correlation (T) is smooth throughout the temperature interval 
used, or else is discontinuous and may cause numerical instability.

Note
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E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define the wall layer.

S P E C I F I C A T I O N

Select an option from the Thermal conductivity list k (SI unit: W/(m·K))—Not set (the 
default), or select User defined to enter a different value or expression. The default is 0.

Select an option from the Wall thickness list w (SI unit: m)—Not set (the default) or 
User defined. If User defined is selected, enter a value or expression. The default is 0.

Initial Values

The Initial Values feature adds an initial value for the temperature that can serve as an 
initial condition for a transient simulation or as an initial guess for a nonlinear solver.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define initial values.

I N I T I A L  V A L U E S

Enter values or expressions for the initial value of the Temperature T (SI unit: K). 

Temperature

Use the Temperature node to specify the temperature at an inlet of the pipe system. 

PO I N T  S E L E C T I O N

From the Selection list, choose the points to apply a temperature.

TE M P E R A T U R E

The equation for this condition is T = T0 where T0 is the prescribed temperature 
(SI unit: K) on the boundary. Enter the value or expression for the Temperature Tin. 
The default is 293.15 K.

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box.


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Heat Outflow

The Heat Outflow node provides a suitable boundary condition for 
convection-dominated heat transfer at outlet boundaries. In a model with convective 
heat transfer, this condition states that the only heat transfer over a boundary is by 
convection. The temperature gradient in the normal direction is zero, and there is no 
radiation. This is usually a good approximation of the conditions at an outlet boundary 
in a heat transfer model with fluid flow.

PO I N T  S E L E C T I O N

From the Selection list, choose the points to apply the heat outflow.
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Th eo r y  f o r  t h e  Hea t  T r a n s f e r  i n  P i p e s  
I n t e r f a c e

The Heat Transfer in Pipes Interface theory is described in this section:

• The Heat Transfer Equation

• Reference for the Heat Transfer in Pipes interface

The Heat Transfer Equation

This interface solves an energy balance equation for 1D pipes, taking the flow velocity 
as input.

H E A T  B A L A N C E  E Q U A T I O N

The energy equation for an incompressible fluid flowing in a pipe is (Ref. 24):

 (3-1)

where  is the fluid density (kg/m3), A is the pipe cross section area (m2) available for 
flow, Cp (J/(kg·K)) is the heat capacity at constant pressure, T (K) is the temperature. 
u is a velocity field. For information about the tangential velocity in pipe flow, see 
Theory for the Pipe Flow Interface. Further, k (W/(m·K)) is the thermal conductivity. 
The second term on the right hand side corresponds to friction heat dissipated due to 
viscous shear. Q (W/m) represents a general heat source and Qwall (W/m) represents 
external heat exchange through the pipe wall. Note that the Qwall term is detailed 
below.

Wall Heat Transfer
The radial heat transfer from the surroundings into the pipe is given by

 (W/m)  (3-2)

In Equation 3-2,  is an effective value of the heat transfer coefficient
h (W/m2·K) times the wall perimeter Z (m) of the pipe. Text (K) the external 
temperature outside of the pipe. See Figure 3-3. Qwall appears as a source term in the 
pipe heat transfer equation, Equation 3-1.

ACp
T
t
------- ACpu T+  Ak T fD+

A
2dh
---------- u 3 Q Qwall+ +=

Qwall hZ eff Text T– =

hZ eff
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The Wall Heat Transfer feature requires the external temperature and at least an 
internal film resistance subnode added to it. The individual contributions of heat 
transfer coefficients can be added by subfeatures to the Wall Heat Transfer feature. The 
subfeatures are:

• Internal Film Resistance

• Wall Layer

• External Film Resistance

Text in Equation 3-2 can be a constant, parameter, expression, or given by a 
temperature field computed by another physics interface, typically a 3D heat transfer 
physics interface. h is automatically calculated through film resistances and wall layers 
that are added as subnodes, see Equation 3-16 an on.

If Text is given as the temperature field computed by another 3D heat transfer 
interface, automatic heat transfer coupling is done to the 3D physics side as a line 
source. The temperature coupling between the pipe and the surrounding domain is 
implemented as a line heat source in the 3D domain. The source strength is 
proportional to the temperature difference (Equation 3-2) between the pipe fluid and 
the surrounding domain.
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The overall heat transfer coefficient including internal film resistance, wall resistance 
and external film resistance can be deduced as follows, with reference to Figure 3-3.

Figure 3-3: Temperature distribution across the pipe wall

• rn (m) is the outer radius of wall n

•  (m) a wall coordinate, starting at the inner radius r0

• (m) the wall thickness of wall n

• Zn (m) is the outer perimeter of wall n

• hint and hext are the film heat transfer coefficients on the inside and outside of the 
tube, respectively (W/(m2, K)).

• kn is the thermal conductivity (W/(m, K)) of wall n,

Shell balance   In Figure 3-3, consider a short length section L of pipe, perpendicular 
to the figure plane. The heat leaving the internal fluid of that segment into the wall is

(W)  (3-3)

Here,  (m2) is the area available for heat flux into the wall. For 
stationary conditions that same amount of heat must travel through any cylindrical 
shell at radius r in wall 1 (or any wall). 

 (3-4)

1 2 NWall number:

T

r

T
T0

T1

T2

TN
Text

n

Tn

r0

wn

rN

r1r0

Layered pipe wall

Fluid domain

dr

w r r0–=

wn rn rn-1–=

Q0 hintAQ T T0– =

AQ L2r0=

Q1 L2r k1
dT
dr
--------– 

 =
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Rearrange and integrate from r0 to r1.

 (3-5)

Perform the integration

 (3-6)

and rearrange

.  (3-7)

For the example of two wall layers, the heat flow is equal across any shell from the inner 
bulk fluid to the surroundings, and we can set all .

 (3-8)

Substituting

,  (3-9)

and making a linear combination of the equations Equation 3-8 gives

 (3-10)

where  is an effective conductance:

 (3-11)

For the general case with N wall layers this reads

Td

T0

T1


Q1

L2k1
--------------------- 1

r
--- 

  rd

r0

r0

–=

T1 T0–
Q1

L2k1
---------------------–

r1
r0
----- 
 ln=

Q1
L2k1

r1
r0
----- 
 ln

--------------------- T0 T1– =

Qn Q=

Q hintL2r0 T T0– =

Q
L2k1

r1 r0 ln
-------------------------- T0 T1– =

Q
L2k2

r2 r1 ln
-------------------------- T1 T2– =

Q hextL2r2 T2 Text– =

 L2=

Q hAQ eff T Text– =

hAQ eff

hAQ eff
1

1
r0hint
-------------------

r1 r0 ln
k1

--------------------------
r2 r1 ln
k2

-------------------------- 1
r2hext
--------------------+ + +

-----------------------------------------------------------------------------------------------------------------=
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 (3-12)

Now let

,  (3-13)

where Z (m) is an average perimeter (circumference), of the pipe, taken over the 
thickness of the pipe walls. Combine Equation 3-9 and Equation 3-13 such a that

and insert in Equation 3-12:

 (3-14)

For a circular pipe cross sections, this effective hZ in can now be used in Equation 3-2. 
Note the reversed sign since Qwall is the heat added to the pipe from the surroundings. 
The assumption in the deduction above is

• equal temperature around the circumference of the pipe

• the heat transfer through the wall is quasi-static. The latter means that the wall is 
assumed to immediately assume the equilibrium temperature distribution 
corresponding to T and Text. If this assumption would not be made, an auxiliary 
PDE across the wall coordinate would be required.

For square and rectangular pipe shapes the average conductance can be approximated 
by the simpler sum of resistances across a plane wall, which can be found in for example 
(Ref. 13):

 (3-15)

hAQ eff
1

1
r0hint
-------------------

rn
rn-1
--------- 
 ln

kn
----------------------

 
 
 
 
 

n 1=

N

 1
rNhext
---------------------+ +

----------------------------------------------------------------------------------------------=

hZ eff

hAQ eff
L

----------------------=

hAQ eff hZ eff 2 =

hZ eff
2

1
r0hint
--------------- 1

rNhext
----------------
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--------- 
 ln

kn
----------------------

 
 
 
 
 
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N

+ +

------------------------------------------------------------------------------------=

hZ eff
1

1
Z0hint
---------------- 1

ZNhext
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kn Zn Z+ n-1  2 
-----------------------------------------------

n=1

N

+ +

--------------------------------------------------------------------------------------------------------=
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The film resistances can be calculated from

 (3-16)

where k is the thermal conductivity of the material, and Nu is the Nusselt number. dh 
is the hydraulic diameter, defined as 

.  (3-17)

• The inner and outer film coefficients is evaluated at (T+T0)/2 and
(TN+Text)/2, respectively.

• The thermal conductivity kn may be temperature dependent and is evaluated at 
(Tn+Tn-1)/2

• To compute dh in Equation 3-17 the local perimeter is calculated as  and 
the cross section area as . Automatic calculations for circular tubes are 
done by the interface as  and . For rectangular tubes it is 

 and . For user-defined pipe shapes, the 
user can enter arbitrary expressions.

The local temperatures in each radial position of the pipe wall (see Figure 3-3) are 
computed considering the fact that Equation 3-2 also can be applied for each 
individual wall layer:

 (3-18)

Combining Equation 3-2, Equation 3-18 and Equation 3-14 or Equation 3-15 
(depending on pipe shape) for each wall layer explicitly gives each Tn.

Internal Film Resistance   For Internal laminar forced convection in fully developed 
pipe flow, the Nusselt number is a constant that depends on the pipe cross-section. 
Values are listed in the table below (Ref. 1). The Pipe Flow interface interpolates to 
find values for width/height ratios not listed. Default settings for film coefficient 
calculations are “Automatic”, which means that laminar and turbulent correlations are 
applied according to the Re number.

TABLE 3-1:  NUSSELT NUMBERS FOR INTERNAL LAMINAR PIPE FLOW

CROSS SECTION WIDTH/HEIGHT NU

circular - 3.66

square 1 2.98

rectangular 1.43 3.08

h Nu k
dh
------=

dh 4A Z=

Z f w( )=

A f w( )=

Z 2r= A r2
=

Z 2 width height+ = A width height=

Qwall hZ eff Tn+1 Tn– =
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For user-defined cross sections, Nu is suggested to 3.66 as a default.

For Internal turbulent forced convection (3000 < Re <  6·106, 0.5 < Pr <  2000), the 
Gnielinski equation (Ref. 18) applies:

 (3-19)

Where Pr is the Prandtl number:

 (3-20)

The film resistance due in the internal flow can be calculated using material properties 
defined in the Heat Transfer feature and the calculated friction factor. Material 
properties are evaluated at the mean internal film temperature (T+T0)/2 (see 
Expressions for the Darcy Friction Factor).

The using the hydraulic diameter makes the equations applicable to non-circular pipe 
cross sections.

External film resistance   The material properties used should be those of the external 
fluid. Do not set the material to Domain Material if you have a different fluid on the 
inside and outside. Typically, the temperature and pressure are required to evaluate the 
material functions. The external fluid velocity is required for the Forced Convection 
option and is a user defined input.

For External forced convection around a pipe, valid for all Re and for Pr > 0.2, the 
Churchill and Bernstein (Ref. 19) correlation is used:

.  (3-21)

rectangular 2 3.39

rectangular 3 3.96

rectangular 4 4.44

rectangular 8 5.60

parallel plates infinity 7.54

TABLE 3-1:  NUSSELT NUMBERS FOR INTERNAL LAMINAR PIPE FLOW

CROSS SECTION WIDTH/HEIGHT NU

Nuint
fD 8  Re 1000– Pr

1 12.7 fD 8 1 2 Pr2 3 1– +
------------------------------------------------------------------------------=

Pr
Cp

k
-----------=

Nuext 0.3 0.62Re1 2 Pr1 3

1 0.4 Pr 2 3
+ 

1 4
------------------------------------------------------- 1 Re 282000 5 8

+ 
4 5

+=
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For External natural convection around a pipe, the Churchill and Chu (Ref. 20) 
correlation is used which is recommend for Ra < 1012:

 (3-22)

where the Rayleigh number is given by:

 (3-23)

and the Grashof number is:

 (3-24)

Above d is the outside diameter of the pipe and,  is the fluid’s coefficient of 
volumetric thermal expansion:

 (3-25)

Material properties are evaluated at (TN+Text)/2.

S T A B I L I Z A T I O N  O F  T H E  H E A T  T R A N S F E R  E Q U A T I O N

The transport equation in the Heat Transfer in Pipes physics is numerically stabilized.

Reference for the Heat Transfer in Pipes interface

1. F.P. Incropera and D.P. DeWitt, Fundamentals of Heat and Mass Transfer, 4th 
ed., John Wiley & Sons, 1996.

Nuext 0.60 0.387Ra1 6

1 0.559 Pr 9 16
+ 

8 27
-------------------------------------------------------------------+

 
 
 2

=

Ra PrGr=

Gr
g TN Text– d3



--- 
  2

-----------------------------------------=

 1

--- 

T
------- 
 

p
–=

Stabilization Techniques in the COMSOL Multiphysics Reference Guide
See Also
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 4
T h e  C h e m i c a l  S p e c i e s  T r a n s p o r t  B r a n c h
This chapter has information about the interfaces available under the Chemical 

Species Transport branch ( ) in the Model Wizard. 

In this chapter:

• The Transport of Diluted Species in Pipes Interface

• The Reacting Pipe Flow Interface

• Theory for the Transport of Diluted Species in Pipes Interface
 77



78 |  C H A P T E R

pipe_ug.book  Page 78  Monday, April 23, 2012  5:04 PM
Th e  T r a n s po r t  o f  D i l u t e d  S p e c i e s  i n  
P i p e s  I n t e r f a c e

The Transport of Diluted Species in Pipes interface ( ), found under the Chemical 

Species Transport branch ( ) in the Model Wizard, has the equations, boundary 
conditions, and reactions order to compute the concentration distribution of a solute 
in a dilute solution, considering diffusion, dispersion, convection, and chemical 
reactions. Note that the Reaction Pipe Flow physics uses this interface and couples it 
automatically to Pipe Flow and Heat Transfer in Pipes.

When this interface is added, these default nodes are also added to the Model Builder—
Convection and Diffusion, Concentration, and Initial Values. Right-click the node to add 
other features that implement, for example, boundary conditions and volume forces.

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is dsp.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list. 

F L U I D  M O D E L

Select a Fluid model—Newtonian (the default), Power law, or Bingham.

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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D E P E N D E N T  V A R I A B L E S

This interface defines these dependent variables (fields)—Number of concentrations c 
(SI unit: mol/m3) and Concentrations.

If required, edit the name, but dependent variables must be unique within a model:

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

Select discretization options from the Concentration list—Quadratic (the default), 
Linear, Cubic, or Quartic.

For each Dependent variable in the table under Value types when using splitting of 

complex variables, choose either a Complex or Real Value type. Click the cell to select 
from a drop-down list.

Edge, Boundary, Point, and Pair Features for the Transport of 
Diluted Species in Pipes Interface

The Transport of Diluted Species in Pipes Interface has these boundary, edge, point, 
and pair features are described in this section:

• Concentration

• Convection and Diffusion

• Initial Values

• Mass Outflow

To enable multiple species (more than one concentration), you need a 
license of either the Batteries and Fuel Cells Module, CFD Module, 
Chemical Reaction Engineering Module, Electrodeposition Module, 
Microfluidics Module, Subsurface flow Module, or the Corrosion 
Module.

Note

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Transport of Diluted 
Species in Pipes Interface

• Theory for the Transport of Diluted Species in Pipes Interface
See Also
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• Pipe Properties (described for the Pipe Flow interface)

• Reactions

• Wall Mass Transfer

Convection and Diffusion

Use the Convection and Diffusion node to define the fluid properties, velocity, diffusion 
coefficient, and dispersion model. This node as present by default.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

M O D E L  I N P U T S

This section contain fields and values that are inputs to expressions that define material 
properties. If such user-defined material models are added, the model inputs appear 
here. Initially, this section is empty.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) uses the value From material. Select User defined 
to enter a different value or expression. 

The default Dynamic viscosity  (SI unit: Pa·s) uses the value From material and 
describes the relationship between the shear rate and the shear stresses in a fluid. 
Intuitively, water and air have a low viscosity, and substances often described as thick, 
such as oil, have a higher viscosity.

In the COMSOL Multiphysics User’s Guide:

• Continuity on Interior Boundaries

• Identity and Contact Pairs 

• Specifying Boundary Conditions for Identity Pairs
See Also

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note
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VE L O C I T Y

Enter a value or expression for the Tangential velocity u (SI unit: m2/s). The default 
is 0.

D I F F U S I O N  C O E F F I C I E N T

Enter a value or expression for the diffusion coefficient Dc (SI unit: m2/s). The default 
is 1 x 10-9 m2/s.

D I S P E R S I O N

Select a Dispersion model—User defined (the default), Taylor (laminar, round pipes), or 
Taylor (turbulent, round pipes). If User defined is selected, enter a value or expression 
for the Dispersion coefficient DD (SI unit: m2/s). The default is 0. Find more detail in 
the theory section Dispersion.

Initial Values

The Initial Values feature adds an initial value for the concentration that can serve as an 
initial condition for a transient simulation or as an initial guess for a nonlinear solver.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the initial values.

I N I T I A L  V A L U E S

Enter values or expressions for the initial value of the Concentration c (SI unit: 
mol/m3). The default is 0.

Reactions

Use the Reactions node to account for the consumption or production of species. 
Define the reaction rate expression as required, which displays on the right-hand side 
of the species transport equations in the Convection and Diffusion node. 

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note
T H E  TR A N S P O R T  O F  D I L U T E D  S P E C I E S  I N  P I P E S  I N T E R F A C E  |  81



82 |  C H A P T E R

pipe_ug.book  Page 82  Monday, April 23, 2012  5:04 PM
E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define the reactions. 

R E A C T I O N S

Enter a Reaction rate Rc (SI unit: mol/(m3·s)). The default is 0.

Wall Mass Transfer

Use the Wall Mass Transfer node to model species loss to the surroundings of the pipe. 
This could be used if the diluted species is soluble in the pipe wall or if the pipe wall is 
semipermeable. A mass transfer coefficient is used to model the loss rate, and external 
bulk concentration i specified to define the driving force.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define the wall mass transfer. 

WA L L  M A S S  TR A N S F E R

For each species, enter a Mass transfer coefficient kwall,c (SI unit: m/s). The default is 0.

For each species, select an option from the list (when available) or define the Bulk 

concentration cbulk (SI unit: mol/m3). The default is 0.

Concentration

The Concentration node adds a point condition for the species concentration. For 
example, a c = c0 condition specifies the concentration of species c.

PO I N T  S E L E C T I O N

From the Selection list, choose the points to define the concentration. 

C O N C E N T R A T I O N

Specify the Concentration cinc (SI unit: mol/(m3·s)) for each species. Enter a value or 
expression in the field for each species. The default is 0.

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
If required, select the Use weak constraints check box.
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Mass Outflow

Use the Mass Outflow feature to define species mass outflow. Mathematically this is 
defined so that convection is the sole contribution to species mass transfer. Normally 
this constitutes a well posed condition for all outflows.

PO I N T  S E L E C T I O N

From the Selection list, choose the points to define the mass outflow. 
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Th e  R e a c t i n g  P i p e  F l ow I n t e r f a c e

The Reacting Pipe Flow interface ( ), found under the Chemical Species Transport 

branch ( ) in the Model Wizard, is a multiphysics interface that combines the three 
interfaces Pipe Flow, Heat Transfer in Pipes, and Transport of Diluted Species in Pipes. 
For the underlying theory, please refer to these respective sections in the 
documentation.

When this interface is added, these default nodes are also added to the Model Builder—
Fluid, Pipe Properties, Temperature, Pressure, Concentration, and Initial Values. 
Right-click the node to add other features that implement, for example, boundary 
conditions and volume forces.

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is rpfl.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list.

F L U I D  M O D E L

Select a Fluid model—Newtonian (the default), Power law, or Bingham.

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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D E P E N D E N T  V A R I A B L E S

This interface defines these dependent variables (fields). If required, edit the name, but 
dependent variables must be unique within a model:

• Pressure p (SI unit: Pa)

• Tangential velocity u (SI unit: m/s)

• Temperature T (SI unit: K)

• Concentration c (SI unit: mol/m3)

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

Select discretization options from the Pressure, Tangential velocity, Temperature, and 
Concentration lists—Quadratic (the default), Linear, Cubic, or Quartic.

For each Dependent variable in the table under Value types when using splitting of 

complex variables, choose either a Complex or Real Value type. Click the cell to select 
from a drop-down list.

Edge, Boundary, Point, and Pair Features for the Reacting Pipe Flow 
Interface 

Because the The Reacting Pipe Flow Interface is a multiphysics interface, many nodes 
are described for other interfaces. These boundary, edge, point, and pair features are 
described as indicated.

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Reacting Pipe Flow 
InterfaceSee Also

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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These features are described in this section:

• Initial Values

• Convection and Diffusion

• Fluid

• Fluid Properties

• Pipe Properties

These features are described for the Pipe Flow interface (listed in alphabetical order): 

• Bend

• Contraction / Expansion

• Inlet

• No Flow

• Outlet

• Pressure

• Pump

• T-Junction

• Valve

These features are described for the Heat Transfer in Pipes interface (listed in 
alphabetical order):

• External Film Resistance

• Heat Outflow

• Heat Source

• Heat Transfer

• Internal Film Resistance

• Temperature

• Wall Heat Transfer

• Wall Layer

Volume Force is described for the Laminar Flow interface in the COMSOL 
Multiphysics User’s Guide:

Note
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These features are described for the Transport of Diluted Species in Pipes interface (listed 
in alphabetical order):

• Concentration

• Mass Outflow

• Reactions

• Wall Mass Transfer

Pipe Properties

The Pipe Properties node is used to define the pipe shape and flow resistance. 

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the pipe properties.

P I P E  S H A P E

F L O W  R E S I S T A N C E

The Friction model is User defined by default. Enter a value or expression for the Darcy 

friction factor fD (unitless). The default is 0.

Initial Values

The Initial Values feature adds initial values for the pressure, tangential velocity, 
temperature, and concentration that can serve as an initial condition for a transient 
simulation or as an initial guess for a nonlinear solver.

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note

The Pipe Shape settings are the same as for the Pipe Properties node 
described for the Pipe Flow interface.

Note
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E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define initial values. 

I N I T I A L  V A L U E S

Enter values or expressions for the initial value of the:

• Pressure p (SI unit: Pa). The default is 101325 Pa.

• Tangential velocity u (SI unit: m/s). The default is 0 m/s.

• Temperature T (SI unit: K). The default is 293.15 K. 

• Concentration c (SI unit: mol/m3). The default is 0 mol/m3.

Fluid Properties

The Fluid Properties feature adds the momentum equations solved by the interface, 
except for volume forces which are added by the Volume Force feature. The node also 
provides an interface for defining the fluid properties of the fluid.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to apply the fluid properties. 

M O D E L  I N P U T S

Edit input variables to the fluid-flow equations if required. For fluid flow, these are 
typically introduced when a material requiring inputs has been applied.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) is User defined and is 1 x 103 kg/m3. Enter a 
different value or expression as required. 

The the fluid model is selected as non-Newtonian, enter a value or expression for the 
more parameters like Yield stress s (SI unit: Pa) and Plastic viscosity s (SI unit: Pa·s). 

Volume Force is described for the Laminar Flow interface in the COMSOL 
Multiphysics User’s Guide:

Note
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Convection and Diffusion

Use the Convection and Diffusion node to define the fluid properties, velocity, diffusion 
coefficient, and dispersion model. This node is present by default.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define the convection and 
diffusion properties. 

M O D E L  I N P U T S

This section contain fields and values that are inputs to expressions that define material 
properties. If such user-defined material models are added, the model inputs appear 
here. Initially, this section is empty.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) is User defined and is 1 x 103 kg/m3. Enter a 
different value or expression as required. 

Enter a value or expression for the Yield stress s (SI unit: Pa) and Plastic viscosity s 
(SI unit: Pa·s). The defaults are 0.

VE L O C I T Y

D I F F U S I O N  C O E F F I C I E N T

Enter a value or expression for the diffusion coefficient Dc (SI unit: m2/s). The default 
is 1 x 10-9 m2/s.

D I S P E R S I O N

Select a Dispersion model—User defined (the default) or Fan (laminar, round pipes). If 
User defined is selected, enter a value or expression for the Dispersion coefficient DD (SI 
unit: m2/s). The default is 0. For detailed information about dispersion, see the theory 
section Dispersion.

No user selection is required for the Tangential velocity u.

Note
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Fluid

Use the Fluid node to define the density, dynamic viscosity, and heat convection and 
conduction properties.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the fluid.

F L U I D  P R O P E R T I E S

The default Density  (SI unit: kg/m3) uses the value From material. Select User defined 
to enter a different value or expression. 

The default Dynamic viscosity  (SI unit: Pa·s) uses the value From material and 
describes the relationship between the shear rate and the shear stresses in a fluid. 
Intuitively, water and air have a low viscosity, and substances often described as thick, 
such as oil, have a higher viscosity.

H E A T  C O N V E C T I O N  A N D  C O N D U C T I O N  

The default Heat capacity at constant pressure Cp (SI unit: J/(kg·K)), Ratio of specific 

heats  (unitless), and Thermal conductivity k (SI unit: W/(m·K)) all use values From 

material. If User defined is selected, enter different values or expressions.

D I S P E R S I O N

Select a Dispersion model—User defined (the default), Taylor (laminar, round pipes), or 
Taylor (turbulent, round pipes). If User defined is selected, enter a value or expression 
for the Dispersion coefficient DD (SI unit: m2/s). The default is 0. For detailed 
information about dispersion, see the theory section Dispersion.

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note
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Th eo r y  f o r  t h e  T r a n s p o r t  o f  D i l u t e d  
S p e c i e s  i n  P i p e s  I n t e r f a c e

The Transport of Diluted Species in Pipes Interface theory is described in this section.

This interface solves a mass balance equation for pipes in order to compute the 
concentration distribution of a solute in a dilute solution, taking the flow velocity as 
input.

M A S S  C O N S E R V A T I O N  E Q U A T I O N

The mass transport equation for a diluted species i an incompressible fluid flowing in 
a pipe is:

 (4-1)

where A (m2) is the cross section area available for flow, ci (mol/m3) is the diluted 
species concentration, and u a velocity field. For information about tangential velocity 
in pipe flow, see Theory for the Pipe Flow Interface. Further, Di (m

2/s) is the species 
diffusion coefficient and DD,i (m

2/s) is the species dispersion coefficient. The second 
term on the right hand side, Rik (mol/(m3·s)), corresponds a source or sink due to 
chemical reaction number k for species i. Finally, Rwall,ik (mol/(m·s)), is a source term 
due to mass transfer contribution k through the pipe wall:

Dispersion
The Transport of Diluted Species in Pipes interface can automatically calculate the axial 
dispersion of species transported in a solvent stream.

For laminar flow in circular, straight pipes the, total dispersion is given by the sum of 
molecular diffusion, Di (m

2/s), and the effect of the velocity profile causing some 
fractions of an initial plane of fluid in the pipe to move faster than others. COMSOL 
uses the Taylor (Ref. 21) correlation for this second contribution, DD,i (m

2/s):

 (4-2)

This expression is valid if:

A
ci
t
------- Au ci+  A Di DD i+  ci  A Rik

k
 Rwall ik

k
+ +=

DD ,i
u2d2

192Di
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 (4-3)

where d is the pipe diameter and L a characteristic pipe length. For turbulent 
conditions Taylor (Ref. 22) suggested:

 (4-4)

For non-Newtonian fluids in the laminar regime Fan (Ref. 23) extended the analysis 
of Taylor:

 (4-5)

with k for Power-law fluids given by:

 (4-6)

and k for Bingham plastic fluids:

 (4-7)

The parameter 0 is

 (4-8)

where R is the pipe radius and r0 is the radius of the plug flow region in the plastic 
flow, defined as

 (4-9)

This can be rewritten as

 (4-10)

where the tangential pressure gradient is calculated by the Pipe Flow interface.
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S T A B I L I Z A T I O N  O F  T H E  M A S S  T R A N S F E R  E Q U A T I O N

The transport equation in the Transport of Diluted Species in pipes physics is 
numerically stabilized.

Stabilization Techniques in the COMSOL Multiphysics Reference Guide
See Also
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 5
T h e  A c o u s t i c s  B r a n c h
This module has extra functionality for simulating acoustics in pipe networks, 
which is found under the Acoustics>Acoustic-Structure Interaction branch ( ) in 
the Model Wizard.

In this chapter:

• The Pipe Acoustics, Transient Interface

• Theory for the Pipe Acoustics, Transient Interface
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Th e  P i p e  A c ou s t i c s ,  T r a n s i e n t  
I n t e r f a c e

The Pipe Acoustics, Transient interface ( ), found under the 
Acoustics>Acoustic-Structure Interaction branch ( ) in the Model Wizard, has the 
equations and boundary conditions for modeling the propagation of transient sound 
waves in flexible pipe systems. The equations are formulated in a general way to include 
the possibility of a stationary background flow.

When this interface is added, these default nodes are also added to the Model Builder—
Fluid Properties, Pipe Properties, Closed, and Initial Values. Right-click the Pipe Acoustics, 

Transient node to add other features.

I N T E R F A C E  I D E N T I F I E R

The interface identifier is a text string that can be used to reference the respective 
physics interface if appropriate. Such situations could occur when coupling this 
interface to another physics interface, or when trying to identify and use variables 
defined by this physics interface, which is used to reach the fields and variables in 
expressions, for example. It can be changed to any unique string in the Identifier field.

The default identifier (for the first interface in the model) is patd.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

The default setting is to include All edges or All boundaries in the model. To choose 
specific edges or boundaries, select Manual from the Selection list. 

This interface requires both the Pipe Flow Module and the Acoustics 
Module.

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

Note

2D

3D
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D E P E N D E N T  V A R I A B L E S

This interface defines these dependent variables (fields). If required, edit the name, but 
dependent variables must be unique within a model:

• Pressure p (SI unit: Pa)

• Tangential velocity u (SI unit: m/s)

D I S C R E T I Z A T I O N

To display this section, click the Show button ( ) and select Discretization. It controls 
the discretization (the element types used in the finite element formulation).

Select discretization options from the Pressure and Tangential velocity lists—Linear, 
Quadratic, Cubic, or Quartic. The defaults is quadratic for the pressure and linear for the 
tangential velocity.

For each Dependent variable in the table under Value types when using splitting of 

complex variables, choose either a Complex or Real Value type. Click the cell to select 
from a drop-down list.

Edge, Boundary, Point, and Pair Features for the Pipe Acoustics, 
Transient Interface

The Pipe Acoustics, Transient Interface has these edge, boundary, point, and pair 
features available and listed in alphabetical order: 

• Closed

• Show More Physics Options

• Edge, Boundary, Point, and Pair Features for the Pipe Acoustics, 
Transient Interface

• Theory for the Pipe Acoustics, Transient Interface
See Also

 

The interface is available in 3D on edges and points, and in 2D on 
boundaries and points.

2D

3D
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• Fluid Properties

• Initial Values

• Open

• Pipe Properties

• Pressure

• Velocity 

Initial Values

The Initial Values feature adds initial values for the pressure and tangential velocity that 
can serve as an initial condition for a transient simulation or as an initial guess for a 
nonlinear solver.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

From the Selection list, choose the edges or boundaries to define initial values. 

I N I T I A L  V A L U E S

Enter values or expressions for the initial value of the Pressure p (SI unit: Pa) and the 
Tangential Velocity u (SI unit: m/s). 

In the COMSOL Multiphysics User’s Guide:

• Volume Force is described for the Laminar Flow interface

• Continuity on Interior Boundaries

• Identity and Contact Pairs 

• Specifying Boundary Conditions for Identity Pairs

The links to the features described in the COMSOL Multiphysics User’s 
Guide do not work in the PDF, only from the online help in COMSOL 
Multiphysics.

To locate and search all the documentation, in COMSOL, select 
Help>Documentation from the main menu and either enter a search term 
or look under a specific module in the documentation tree.

See Also

Important

Tip
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Fluid Properties

The Fluid Properties feature adds the momentum and continuity equations solved by 
the interface, except for volume forces which are added by the Volume Force feature. 
The node also provides an interface for defining the material properties of the fluid.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the fluid properties. 

M O D E L  I N P U T S

Edit input variables to the fluid-flow equations if required. For fluid flow, these are 
typically introduced when a material requiring inputs has been applied.

B A C K G R O U N D  P R O P E R T I E S

Enter a value or expression for the Background velocity u0 (SI unit: m/s) and 
Background pressure p0 (SI unit: Pa). 

P H Y S I C A L  P R O P E R T I E S

Select a Fluid model—Linear elastic (the default).

The default Density  (SI unit: kg/m3) uses the value From material. Select User defined 
to enter a different value or expression. 

The default Speed of sound cs (SI unit: m/s) uses the value From material. Select User 

defined to enter a different value or expression.

Volume Force is described for the Laminar Flow interface in the COMSOL 
Multiphysics User’s Guide:

Note

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note
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Pipe Properties

The Pipe Properties node is used to define the pipe shape, pipe model, wall drag force, 
and swirl correction.

E D G E  O R  B O U N D A R Y  S E L E C T I O N

When additional nodes are added, from the Selection list choose the boundaries or 
edges to define the pipe properties.

P I P E  S H A P E

Select a pipe shape from the list—Not set (the default), Round, Square, Rectangular, or 
User defined.

• If Round is selected, enter a value or expression for the Inner diameter di (SI unit: 
m). The default is 10 cm.

• If Square is selected, enter a value or expression for the Inner width wi (SI unit: m). 
The default is 5 cm.

• If Rectangular is selected, enter a value or expression for the Inner width wi (SI 
unit: m. The default is 5 cm) and Inner height hi (SI unit: m. The default is 10cm).

• If User defined is selected, enter a value or expression for the Cross sectional area Ac 
(SI unit: m2. The default is 0.01 m2) and Wetted perimeter Z (SI unit: m. The 
default is 0.4 m).

P I P E  M O D E L

Select a Pipe model—Incompressible cross section (the default), Zero axial stress, 
Anchored at one end, or Anchored at both ends. When Zero axial stress, Anchored at one 

end, or Anchored at both ends is selected, also select a Thickness w—Not set (the 
default) or User defined. If User defined is selected, enter a value or expression.

• When Anchored at one end or Anchored at both ends is selected, also select a Poisson’s 

ratio v—Not set (the default) or User defined. If User defined is selected, enter a value 
or expression.

For the default node no user selection is required. All boundaries or All 

edges is automatically selected.
Note


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WA L L  D R A G  F O R C E

Enter a value or expression for w (SI unit: N/m2). The default is 0.

S W I R L  C O R R E C T I O N

Enter a value or expression for  (unitless). The default is 1.

Closed

Use the Closed feature to impose zero velocity. This is the default condition added on 
all end points.

PO I N T  S E L E C T I O N

From the Selection list, choose the closed points.

Open

Use the Open feature to model an open pipe end where waves propagate out of the 
system without any reflections. The boundary condition prescribes the velocity given 
for plane waves moving in an infinitely long pipe of constant cross section area A. The 
relation between the pressure p and tangential velocity u is given by

where u0 is the background tangential flow, c is the wave speed,  is the fluid density, 
Ais the cross sectional area compressibility, and is the swirl correction factor. 

Theory for the Pipe Acoustics, Transient Interface Boundary Conditions
See Also

u
p
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Theory for the Pipe Acoustics, Transient Interface Boundary Conditions
See Also
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PO I N T  S E L E C T I O N

From the Selection list, choose the open points.

Pressure

Use the Pressure node to define the boundary pressure at the pipe ends.

PO I N T  S E L E C T I O N

From the Selection list choose the points that represent the pressure.

P R E S S U R E

Enter a value or expression for the Pressure p (SI unit: Pa). The default is 0 Pa.

C O N S T R A I N T  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Select a Constraint type—Bidirectional, symmetric or Unidirectional. If required, select 
the Use weak constraints check box.

Velocity

Use the Velocity feature to prescribe a velocity at the pipe ends.

The wave speed c may be different from the speed of sound cs and 
depends on the elastic properties of the pipe structure. It is defined in 
Equation 5-3 in the Governing Equations section.

The wave speed may be evaluated as sqrt(1/patd.invc2) during the 
analysis and results stage.

Note

Theory for the Pipe Acoustics, Transient Interface Boundary Conditions
See Also

Theory for the Pipe Acoustics, Transient Interface Boundary Conditions
See Also
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PO I N T  S E L E C T I O N

From the Selection list, choose the velocity points.

VE L O C I T Y

Enter a value or expression for uin (SI unit: m/s). The default is 0.
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Th eo r y  f o r  t h e  P i p e  A c ou s t i c s ,  
T r a n s i e n t  I n t e r f a c e

The equations governing the propagation of sound in pipes stem from considering 
momentum, mass, and energy balances for a control volume of a piece of pipe. The 
resulting equations are expressed in the cross-sectional averaged variables and reduces 
the equations to a 1D model with scalar dependent variables. The present theory 
assumes no thermal conduction and thus no losses due to thermal conduction 
(isentropic sound propagation).

The Pipe Acoustics, Transient Interface theory is discussed in this section:

• Governing Equations

• Theory for the Pipe Acoustics, Transient Interface Boundary Conditions

• Solving Transient Problems

• References for the Pipe Acoustics, Transient Interface

Governing Equations

The continuity equation derived for a control volume is given by

 (5-1)

and the corresponding momentum balance equation is

 (5-2)

where Z is the inner circumference of the pipe and A = A(x,p,...) is the inner wetted 
cross sectional area. u is the area-averaged mean velocity, and it is also defined in the 
tangential direction u = uet, p is the mean pressure along the pipe, fdrag is the drag 
force, and F is a volume force. The gradient is taken in the tangential direction et. The 

The Pipe Acoustics, Transient interface requires both the Pipe Flow 
Module and the Acoustics Module.

Note

 A 
t

----------------  Au + 0=

 Au 
t

--------------------  Au2 +  Ap – fdragZ AF+ +=
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term  is a swirl-correction factor relating the mean of the squared total velocity to the 
square of the mean velocity. Such that 

where

 and 

are here the local parameters. Again p and u are the are the area-averaged dependent 
variables.

L I N E A R I Z A T I O N

The governing equations are now linearized, that is, all variables are expanded to first 
order assuming stationary zero (0th) order values (steady state background 
properties). The acoustic variations of the dependent variables are assumed small and 
on top of the background values. This is done according to the following scheme:

where A0 is often only function of x, however A0 may be changed by external factors 
such as heating or structural deformation, thus the time dependency. The 1st order 
terms represent small perturbations on top of the background values (0th order). They 
are valid for

Moreover, the perturbations for the fluid density and cross section area are expanded 
to first order in p0 in a Taylor series such that

u 1
A
---- ũ Ad= p 1

A
---- p̃ Ad=  1

A
---- ũ

2
Ad 

 
 
  u2=

p̃ p̃ x = ũ ũ x =

u x t  u0 x  u1 x t +=

p x t  p0 x  p1 x t +=

 x t  0 x  1 x t +=

A x t  A0 x  A1 x t +=

1 0« p1 0c0
2

« u1 c0« A1 A0«

1  0– p p0–  
p
------

s 0

= =

A1 A A0– p p0–  A
p
-------

s 0

= =
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where the subscript s refers to constant entropy, that is, the processes are isentropic. 
The relations for the fluid compressibility and the cross sectional area compressibility 
are

here, 0 is the fluid compressibility at the given reference pressure p0, the isentropic 
bulk speed of sound is denoted cs, and 0 is the fluid density at the given reference 
temperature and reference pressure. A is the effective compressibility of the pipe’s 
cross section A0 due to changes in the inner fluid pressure.

Inserting the above expansions into the governing equations (Equation 5-1 and 
Equation 5-2) and retaining only 1st order terms yield the pipe acoustics equations 
including background flow. These are (after some manipulation and dropping the 
suffix 1 on the acoustic variations):

 (5-3)

The bulk modulus for the cross sectional area KA is given by the pipe material 
properties according to the so-called Korteweg formula (see Ref. 2).

Finally, using the fact that the velocity is taken along the tangential direction et the 
governing equations are re-written in terms of the scalar values u and p, and projecting 
onto the tangent. The 0 subscript is dropped on the density and area and the 1 
subscript is also dropped on the dependent variables.

0
1

K0
------- 1

Ks
------ 1

0
------ 

p
------

s 0

1
0
------ 1

cs
2

-----= = = =

A
1

A0
-------=

A
p
-------

s 0

A0
1

c2
-----p

t
------  A00 u1

u0

0c2
-----------p+

 
 
 

 
 
 
+ 0=

0A0
u
t
-------

u0

0c2
-----------p

t
------+

 
 
 

 A0
u0

2

c2
------p 20A0u0u+

 
 
 

+

 A0p  1 p0A+   f+ dragZ+ 0=

1

c2
----- 0 0 A+  0

1
K0
------- 1

KA
-------+ 

  1

cs
2

-----
0
KA
-------+= = =
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 (5-4)

where w is the tangential wall drag force (SI unit: N/m2) and F is a volume force 
(SI unit: N/m3).

Theory for the Pipe Acoustics, Transient Interface Boundary 
Conditions

The simplest boundary conditions to specify are to prescribe the pressure or the 
velocity at the pipe ends. These result in the Pressure condition

and the Velocity condition

and can be set independently of each other leaving the other dependent variable free. 
A special subclass of the velocity condition is the Closed condition where

this corresponds to the sound-hard wall condition in pressure acoustics.

The final condition to specify is the Open condition. In this case it is assumed that the 
pipe continues with constant cross section A. This requires specifying as the acoustic 
waves are, by design, always normal to the pipe ends, for example, the velocity as a 
function of the pressure. In order to define this, the dispersion relation and the relation 
between p and u for a plane wave needs to be determined.

To determine these relations insert the assumed plane wave form

A 1

c2
-----p

t
------  A u

u0

c2
---------p+

 
 
 

 
 
 

et+ 0=

A u
t
------

u0

c2
---------p

t
------+

 
 
 

 A
u0

2

c2
------p 2Au0u+

 
 
 

et+

 Ap 1 p0A+   et wZ+ A F et + + 0=

1

c2
-----  0 A+   1

K0
------- 1

KA
-------+ 

  1

cs
2

----- 
KA
-------+= = =

p pin=

u uin=

u 0=
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into the governing Equation 5-4 and solve for the desired relations. After some 
manipulation this results in

with the dispersion relation

such that the relation

must hold at an open boundary.

Solving Transient Problems

When solving transient acoustic problems where the wave shape is not necessarily 
harmonic it may be necessary to resolve its spatial variations with a fine mesh, say with 
a minimal scale dx. Now, in order for the numerical solution of the temporal 
development of the acoustic field to be good it is necessary to restrict the maximal time 
steps dt taken by the solver The condition is known as the CFL condition. For 
transient acoustic problems it is defined as

This conditions restricts any acoustic disturbances to propagate more than 20 % of the 
mesh size dx during one time step dt.

p Re p̃ei t kx–  =

u Re ũei t kx–  =

u
p
--- 1

c2
-----1

--- 

k
---- u0– 
 =


k
---- u0 c   1– 

u0
c

------ 
 

2
1 Ap0+ ++=

u
p
--- 1

c2
-----1

---  1– u0 c   1– 

u0
c

------ 
 

2
1 Ap0+ ++

 
 
 

=

CFL dx
c dt
------------- 0,2= =

For an example of a model where the CFL condition is used see Water 
Hammer: Model Library path Pipe_Flow_Module/Verification_Models/

water_hammer_verification.Model
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References for the Pipe Acoustics, Transient Interface

1. D. T. Blackstock, Fundamentals of Physical Acoustics, John Wiley & Sons, 2000.

2. M. S. Ghidaoui, M. Zhao, D. A. McInnis, and D. H. Axworthy, A Review of Water 
Hammer Theory and Practice, Applied Mechanics Reviews, ASME, 2005.
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 6
M a t e r i a l s
This chapter describes how to use the material databases.

In this chapter:

• Material Library and Databases

• Liquids and Gases Materials Database
 111
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Ma t e r i a l  L i b r a r y  and Da t aba s e s

The Pipe Flow Module includes the Liquids and Gases material database with 
temperature-dependent fluid dynamic and thermal properties. 

In this section:

• About the Material Databases

• About Using Materials in COMSOL

• Opening the Material Browser

• Using Material Properties

About the Material Databases

All COMSOL modules have predefined material data available to build models. The 
most extensive material data is contained in the separately purchased Material Library, 

For detailed information about all the other material databases and the 
separately purchased Material Library, see Materials in the COMSOL 
Multiphysics User’s Guide.Note

Material Browser—select predefined 
materials in all applications.

Material Library—Purchased 
separately. Select from over 2500 
predefined materials.

Built-In database—Available to all 
users and contains common materials. 

Application specific material databases 
available with specific modules.

User-defined material database library.

Recent Materials—Select from recent 
materials added to the model.
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but all modules contain commonly used or module-specific materials. For example, the 
Built-In database is available to all users but the MEMS database is included with the 
MEMS Module and Structural Mechanics Module. Also create custom materials and 
material libraries by researching and entering material properties.

All the material databases (including the Material Library) are accessed from the 
Material Browser. These databases are briefly described below.

R E C E N T  M A T E R I A L S

From the Recent Materials folder ( ), select from a list of recently used materials, with 
the most recent at the top. This folder is available after the first time a material is added 
to a model.

M A T E R I A L  L I B R A R Y

An optional add-on database, the Material Library ( ), contains data for over 2500 
materials and 20,000 property functions.

B U I L T - I N

Included with COMSOL Multiphysics, the Built-In database ( ) contains common 
solid materials with electrical, structural, and thermal properties. 

A C / D C

Included in the AC/DC Module, the AC/DC database ( ) has electric properties for 
some magnetic and conductive materials.

B A T T E R I E S  A N D  F U E L  C E L L S

Included in the Batteries & Fuel Cells Module, the Batteries and Fuel Cells 
database ( ) includes properties for electrolytes and electrode reactions for certain 
battery chemistries.

L I Q U I D S  A N D  G A S E S

Included in the Acoustics Module, CFD Module, Chemical Reaction Engineering 
Module, Heat Transfer Module, MEMS Module, Pipe Flow Module, and Subsurface 

Predefined Built-In Materials for all COMSOL Modules in the COMSOL 
Multiphysics User’s Guide

See Also
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Flow Module, the Liquids and Gases database ( ) includes transport properties and 
surface tension data for liquid/gas and liquid/liquid interfaces.

M E M S

Included in the MEMS Module and Structural Mechanics Module, the MEMS 
database ( ) has properties for MEMS materials—metals, semiconductors, 
insulators, and polymers.

P I E Z O E L E C T R I C

Included in the Acoustics Module, MEMS Module, and Structural Mechanics 
Module, the Piezoelectric database ( ) has properties for piezoelectric materials.

P I E Z O R E S I S T I V I T Y

Included in the MEMS Module, the Piezoresistivity database ( ) has properties for 
piezoresistive materials, including p-Silicon and n-Silicon materials.

U S E R - D E F I N E D  L I B R A R Y

The User-Defined Library folder ( ) is where user-defined materials databases 
(libraries) are created. When any new database is created, this also displays in the 
Material Browser.

About Using Materials in COMSOL

U S I N G  T H E  M A T E R I A L S  I N  T H E  P H Y S I C S  S E T T I N G S

The physics set-up in a model is determined by a combination of settings in the 
Materials and physics interface nodes. When the first material is added to a model, 
COMSOL automatically assigns that material to the entire geometry. Different 
geometric entities can have different materials. The following example uses the 

The materials databases shipped with COMSOL Multiphysics are 
read-only. This includes the Material Library and any materials shipped 
with the optional modules.

Creating Your Own User-Defined Libraries in the COMSOL 
Multiphysics User’s Guide

Important

See Also
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heat_sink.mph model file contained in the Heat Transfer Module and CFD Module 
Model Libraries. 

Figure 6-1: Assigning materials to a heat sink model. Air is assigned as the material to 
the box surrounding the heat sink, and aluminum to the heat sink itself.

If a geometry consists of a heat sink in a container, Air can be assigned as the material 
in the container surrounding the heat sink and Aluminum as the heat sink material itself 
(see Figure 6-1). The Conjugate Heat Transfer interface, selected during model set-up, 
has a Fluid flow model, defined in the box surrounding the heat sink, and a Heat 

Transfer model, defined in both the aluminum heat sink and in the air box. The Heat 

Transfer in Solids 1 settings use the material properties associated to the Aluminum 

3003-H18 materials node, and the Fluid 1 settings define the flow using the Air material 
properties. The other nodes under Conjugate Heat Transfer define the initial and 
boundary conditions.

All physics interface properties automatically use the correct Materials’ properties when 
the default From material setting is used. This means that one node can be used to 
define the physics across several domains with different materials; COMSOL then uses 
the material properties from the different materials to define the physics in each 
domain. If material properties are missing, the Material Contents section on the 
M A T E R I A L  L I B R A R Y  A N D  D A T A B A S E S  |  115
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Materials page displays a stop icon ( ) to warn about the missing properties and a 
warning icon ( ) if the property exists but its value is undefined. 

There are also some physics interface features where you can explicitly select a material 
from which material properties are retrieved. The default setting is then always to use 
the Domain material on each domain (that is, the materials defined on the same 
domains as the physics interface). In addition to the Domain Material, you can select 
any other material that is present in the model, regardless of its selection. The selected 
material’s properties are then applied to all domains in the feature’s selection.

E V A L U A T I N G  A N D  P L O T T I N G  M A T E R I A L  P R O P E R T I E S

You can access the material properties for evaluation and plotting like other variables 
in a model using the variable naming conventions and scoping mechanisms:

• To access a material property throughout the model (across several materials) and 
not just in a specific material, use the special material container root.material. For 
example, root.material.rho is the density  as defined by the materials in each 
domain in the geometry. For plotting, you can type the expression material.rho 
to create a plot that shows the density of all materials.

• To access a material property from a specific material, you need to know the tags for 
the material and the property group. Typically, for the first material (Material 1) the 
tag is mat1 and most properties reside in the default Basic property group with the 
tag def. The variable names appear in the Variable column in the table under Output 

properties in the settings window for the property group; for example, Cp for the 
heat capacity at constant pressure. The syntax for referencing the heat capacity at 
constant pressure in Material 1 is then mat1.def.Cp. Some properties are 
anisotropic tensors, and each of the components can be accessed, such as 

The Material Page in the COMSOL Multiphysics User’s Guide
See Also

If you use a temperature-dependent material, each material contribution 
asks for a special model input. For example, rho(T) in a material mat1 
asks for root.mat1.def.T, and you need to define this variable (T) 
manually—if the temperature is not available as a dependent variable—to 
make the density variable work.

Note
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mat1.def.k11, mat1.def.k12, and so on, for the thermal conductivity. For 
material properties that are functions, call these with input arguments such as 
mat1.def.rho(pA,T) where pA and T are numerical values or variables 
representing the absolute pressure and the temperature, respectively. The functions 
can be plotted directly from the function nodes’ settings window by first specifying 
suitable ranges for the input arguments.

• Many physics interfaces also define variables for the material properties that they 
use. For example, solid.rho is the density in the Solid Mechanics interface and is 
equal to the density in a material when it is used in the domains where the Solid 
Mechanics interface is active. If you define the density in the Solid Mechanics 
interface using another value, solid.rho represents that value and not the density 
of the material. If you use the density from the material everywhere in the model, 
solid.rho and material.rho are identical.

Opening the Material Browser 

1 Open or create a model file.

2 From the View menu choose Material Browser or right-click the Materials node and 
choose Open Material Browser.

The Material Browser opens by default in the same position as the settings window.

3 Under Material Selection, search or browse for materials.

- Enter a Search term to find a specific material by name, UNS number (Material 
Library materials only), or DIN number (Material Library materials only). If the 
search is successful, a list of filtered databases containing that material displays 
under Material Selection.

When using the Material Browser, the words window and page are 
interchangeable. For simplicity, the instructions refer only to the Material 

Browser.Note

To clear the search field and browse, delete the search term and click 
Search to reload all the databases.

Tip
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- Click to open each database and browse for a specific material by class (for 
example, in the Material Library) or physics module (for example, MEMS 
Materials).

4 When the material is located, right-click to Add Material to Model.

A node with the material name is added to the Model Builder and the Material page 
opens.

Using Material Properties 

Always review the material properties to confirm they are applicable for 
the model. For example, Air provides temperature-dependent properties 
that are valid at pressures around 1 atm.Important

For detailed instructions, see Adding Predefined Materials and Material 
Properties Reference in the COMSOL Multiphysics User’s Guide.

See Also
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L i q u i d s  and Ga s e s  Ma t e r i a l s  Da t a b a s e

In this section:

• Liquids and Gases Materials

• References for the Liquids and Gases Material Database

Liquids and Gases Materials

The Liquids and Gases materials database contains thermal and fluid dynamic 
properties for a set of common liquids. All properties are given as functions of 
temperature and at atmospheric pressure, except the density, which for gases is also a 
function of the local pressure. The database also contains surface and interface tensions 

For an example of the Liquids and Gases materials database, see 
Discharging Tank: Model Library path Pipe_Flow_Module/Tutorial_Models/

discharging_tank.Model
L I Q U I D S  A N D  G A S E S  M A T E R I A L S  D A T A B A S E  |  119
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for a selected set of liquid/gas and liquid/liquid systems. All functions are based on 
data collected from scientific publications. 

D E F A U L T  G R A P H I C S  W I N D O W  A P P E A R A N C E  S E T T I N G S   

TABLE 6-1:  LIQUIDS AND GASES MATERIALS

GROUP MATERIAL

Gases References 1, 2, 7, 8, 11, 
and 12

Air

Nitrogen

Oxygen

Carbon dioxide

Humid air

Hydrogen

Helium

Steam

Propane

Ethanol vapor

Diethyl ether vapor

Freon12 vapor

SiF4

Liquids References 2, 3, 4, 5, 6, 7, 
9, and 10

Engine oil

Ethanol

Diethyl ether

Ethylene glycol

Gasoline

Glycerol

Heptane

Mercury

Toluene

Transformer oil

Water

The MEMS Materials database has data for these materials and a default 
appearance for 3D models is applied to each material as indicated.

3D
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References for the Liquids and Gases Material Database

1. ASHRAE Handbook of Fundamentals, American Society of Heating, 
Refrigerating and Air Conditioning Engineers, 1993.

2. E. R. G. Eckert and M. Drake, Jr., Analysis of Heat and Mass Transfer, 
Hemisphere Publishing, 1987.

3. H. Kashiwagi, T. Hashimoto, Y. Tanaka, H. Kubota, and T. Makita, “Thermal 
Conductivity and Density of Toluene in the Temperature Range 273-373K at 
Pressures up to 250 MPa,” Int. J. Thermophys., vol. 3, no. 3, pp. 201–215, 1982.

See Working on the Material Page in the COMSOL Multiphysics User’s 
Guide for more information about customizing the material’s appearance 
in the Graphics window.

TABLE 6-2:  MATERIALS 3D MODEL DEFAULT APPEARANCE SETTINGS

MATERIAL DEFAULT 
FAMILY
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All gases Air Simple 0.08 3 0.1 - - -

All liquids 
(except Engine 
oil, Mercury, and 
Transformer oil)

Water Cook- 
Torrance

0.2 0.2 0.2 - 0.7 0.05

Engine oil Custom Cook- 
Torrance

0.2 0.2 0.2 - 0.7 0.05

Mercury Custom Cook- 
Torrance

0 1 1 - 0.9 0.1

Transformer oil Plastic Blinn-Phon
g

0 1 1 64 - -

See Also
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4. C. A. Nieto de Castro, S.F.Y. Li, A. Nagashima, R.D. Trengove, and W.A. 
Wakeham, “Standard Reference Data for the Thermal Conductivity of Liquids,” J. 
Phys. Chem. Ref. Data, vol. 15, no. 3, pp. 1073–1086, 1986.

5. B.E. Poling, J.M. Prausnitz, and J.P. O’Connell, The Properties of Gases and 
Liquids, 5th ed., McGraw-Hill, 2001.

6. C.F. Spencer and B.A. Adler, “A Critical Review of Equations for Predicting 
Saturated Liquid Density,” J. Chem. Eng. Data, vol. 23, no. 1, pp. 82–88, 1978.

7. N.B.Vargnaftik, Tables of Thermophysical Properties of Liquids and Gases, 2nd 
ed., Hemisphere Publishing, 1975.

8. R.C.Weast (editor), CRC Handbook of Chemistry and Physics, 69th ed., CRC 
Press, 1988.

9. M. Zabransky and V. Ruzicka, Jr., “Heat Capacity of Liquid n-Heptane Converted 
to the International Temperature Scale of 1990,” Phys. Chem. Ref. Data, vol. 23, 
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